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Due parole 
Questo .pdf è parte integrante del libro Creare fumetti con Clip Studio Paint e 

raccoglie quella parte del testo che, per motivi di spazio, si è preferito non inserire 
nel libro cartaceo. 

 

Oltre a capitoli che completano la panoramica sugli aspetti del programma, 
come l'analisi delle Preferences o degli effetti dei vari Blending Mode, oppure la 
disamina delle possibilità di acquisto per le varie versioni, introduco alcuni concet-
ti che possono essere utili seppur non indispensabili, ad esempio come destreg-
giarsi tra le unità di misura oppure delle -forzatamente- brevi introduzioni a mate-
rie come l'animazione in CSP o l'utilizzo di Clip Studio Modeler. 

Concludono l'insieme, qualche appunto sull'utilizzo del colore e un compendio 
delle scorciatoie da tastiera.  

 

Ci sono diversi riferimenti sia a parte di queste Risorse che a parti trattate nel 
testo cartaceo: se è indicato solo il numero di pagina, il riferimento è alle Risorse; 
diversamente, specifico dove trovare ciò di cui parlo. 

 

Buona lettura! 
 
 

maggio 2024 Matteo Paolelli 
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Acquisto e installazione 

V. 3.0 -  Nuovi utenti 
A marzo 2024 è uscita la v. 3.0 .  
I nuovi utenti, ossia coloro che non hanno mai utilizzato CSP, possono 

acquistare una licenza v. 3 Perpetual, cioè che si paga una volta, si ha la 
versione 3 aggiornata che rimane utilizzabile per sempre, ma non si hanno 
automaticamente i successivi aggiornamenti; per tenere aggiornato il pro-
gramma bisogna acquistare un Update Pass (UP) annuale, che garantirà il 
programma aggiornato fintanto che sarà valido (cioè per un anno 
dall’acquisto, rinnovabile alla scadenza). 

In alternativa, invece dell'acquisto della licenza Perpetual e successivi 
UP, si può sottoscrivere un abbonamento mensile o annuale, che manterrà 
il programma sempre aggiornato, indipendentemente da quando lo si ac-
quisti, fintanto che l'abbonamento sarà attivo. 

Alla pagina tinyurl.com/ynh4348k si possono acquistare le licenze Perpe-
tual e gli abbonamenti (con i quali il programma è sempre aggiornato);  
cliccando sulla scheda Upgrades si apre la pagina da cui effettuare 
l’upgrade tra le edizioni o acquistare l’Update Pass.  

 

Se si possiede già la v. 2 
Chi ha già una v. 2 Perpetual, per tenere il programma aggiornato senza 

acquistare la v. 3 Perpetual deve acquistare l'UP. 
 Se si vuole acquistare una v. 3 Perpetual, ci sono degli sconti arrivando 

dalla v. 2 Perpetual per la stessa edizione (da PRO a PRO o da EX a EX) e an-
che per passare dalla 2.0 PRO alla 3.0 EX. Dopodiché, per tenere il pro-
gramma aggiornato bisogna acquistare l'UP annuale. 

 

Se si possiede già la  v. 1 
Per chi arriva dalla v. 1 Perpetual: o acquista direttamente l'UP annuale 

o, se desidera avere la v. 3 Perpetual, deve prima passare alla v. 2 Perpetual 
(con sconto) e poi dalla v. 2 Perpetual alla v. 3 Perpetual (anche questa con 
sconto): non è possibile passare direttamente dalla v. 1 Perpetual alla v. 3 
Perpetual. Se sta già usando l'UP, l'aggiornamento alle funzionalità della v. 
3 è automatico, salvo tornare alla Perpetual che si aveva prima dell'acqui-
sto dell'UP se non viene confermato alla sua scadenza. 

 

Si può acquistare un Update Pass solo se di base si possiede una Perpe-
tual, v. 1, v. 2 o v.3 . Se ho ad esempio una v. 1 EX Perpetual, posso evitare 
di acquistare una v. 3 Perpetual e acquistare direttamente un UP-EX. 

https://tinyurl.com/ynh4348k
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Se si decide di non sottoscrivere più l'Update Pass la versione aggiornata 
non funzionerà più: dovrà essere disinstallata per reinstallare la versione 
che si aveva prima di fare l'aggiornamento (la X.x.x, o l'ultima versione Per-
petual acquistata). 

 

Attenzione: l'Update Pass è relativo alla licenza Perpetual di partenza.  
Ciò significa che se ho una licenza Perpetual PRO, posso acquistare un 

Update Pass con funzionalità PRO, non posso fare gli aggiornamenti per la 
EX. Lo stesso dicasi se in partenza ho una Perpetual EX: non posso fare gli 
aggiornamenti solo per la PRO (rinunciando per ipotesi alle funzionalità del-
la EX). Se si volesse mantenere la Perpetual PRO e si vogliono usare le fun-
zionalità EX, Celsys consiglia la sottoscrizione di un abbonamento EX a par-
te. 

 

Quanto costa la v. 3.0? 
Acquisto della v. 3  Perpetual: 

PRO 
EX 

54,00 US$ 
237,00 US$ 

 

Abbonamenti, per un solo dispositivo (Windows / macOS / iPad / iPhone / 

Galaxy / Android / Chromebook): 
 Mensile Annuale 

PRO 
EX 

4,49 US$ 
8,99 US$ 

26,99 US$ 
76,99 US$ 

 

Il prezzo in € dipende dal cambio al momento dell’acquisto. Si possono 
verificare le novità e le altre modalità di acquisto della v. 3 anche alle pagi-
ne  tinyurl.com/3ufrj2c5 , tinyurl.com/5fd9wnfn e tinyurl.com/mr756zve 
(quest’ultima per gli abbonamenti). 

In breve, i prezzi dei vari upgrade e degli Update Pass sono i seguenti: 
 

Upgrade  dalla alla   Update Pass annuale 
 DEBUT  1 PRO 2 44,99 US$  PRO 10,99 US$ 
 PRO 1 PRO 2 19,99 US$  EX 31,99 US$ 
  EX 2 188,99 US$   
 PRO 2 PRO 3 22,99 US$   
  EX 2 169,00 US$   
  EX 3 205,99 US$ Prezzi aggiornati ad aprile 2024 

 PRO 3 EX 3 183,00 US$   
 EX 1 EX 2 56,99 US$   
 EX 2 EX 3 65,99 US$   

 
 
 

https://tinyurl.com/3ufrj2c5
https://www.tinyurl.com/5fd9wnfn
https://tinyurl.com/mr756zve
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Vecchie versioni e aggiornamenti 
Dalla v. 2.0, il supporto gratuito per gli aggiornamenti per la v. 1.x.x è 

cessato, ma rimane quello per bug o errori dipendenti dal sistema operati-
vo (contrariamente a quanto annunciato inizialmente, è così anche dopo il 
rilascio della v. 3: in sostanza, presumo che intendano fino al rilascio della 
v.4: (vedi anche la tabella Product update flowchart alla pagina tin-

yurl.com/yhrebezj). Dal rilascio della v. 4.0, verrà cessato ogni supporto an-
che per la v. 2.x.x. 

 

Si può installare CSP su più di un computer? 
Dall’uscita della v. 2, con l’acquisto Perpetual (PC o Mac, vedi tin-

yurl.com/ynh4348k) installando il programma su una seconda macchina bi-
sogna disattivare la licenza sulla prima. Se non lo si fa, dovrebbe apparire 
un messaggio nel nuovo computer, con  le istruzioni per disattivare la licen-
za in eccesso.  

Con i piani in abbonamento, il numero di dispositivi in cui si può installa-
re va da uno fino a quattro (tra Win, macOS, iPad, iPhone, Galaxy, Android 
o Chromebook); vedi  tinyurl.com/mr756zve e tinyurl.com/mr45bf4u; leggi 
questo post tinyurl.com/2hbxjjzm. 

 

Devo passare da un dispositivo a un altro: mentre con la v.1  bastava non 
utilizzarli contemporaneamente, ora come si fa? 

Se si ha la licenza per un solo dispositivo, Celsys dice che per passare a 
un altro bisogna prima effettuare lo switch, ossia revocare la licenza sul 
primo e attivarla sul secondo. Il problema è che il numero di switch possibi-
li è limitato e quale questo sia è un’informazione che Celsys non vuole di-
vulgare. L’indicazione è quindi quella di effettuare lo switch solo se si è co-
stretti (es. cambio/formattazione PC) e non per poter saltare da un disposi-
tivo a un altro a seconda della comodità. Credo che rientri in una precisa 
scelta di far acquistare una licenza per più dispositivi. 
 

Ricapitolando  
In breve, si può: 

 acquistare la licenza Perpetual (paghi una volta e il programma ti rima-
ne, ma non hai automaticamente gli aggiornamenti); 

 acquistare la licenza Perpetual, e in seguito, per tenerla aggiornata, ac-
quisti ogni anno un Update Pass che ti dà diritto a tutti gli aggiornamenti. 
Se smetti poi di acquistare l'Update Pass, puoi tornare alla versione che a-
vevi prima o alla licenza Perpetual che avevi acquistato; 

https://tinyurl.com/yhrebezj
https://tinyurl.com/yhrebezj
https://tinyurl.com/ynh4348k
https://tinyurl.com/ynh4348k
https://tinyurl.com/mr756zve
https://tinyurl.com/mr45bf4u
https://www.facebook.com/groups/mangastudioitalia/permalink/3376888895755420
https://tinyurl.com/2hbxjjzm


10 
 

 acquistare solo l'Update Pass, a partire da subito, se hai almeno una v. 
1.x.x (questa ad esempio è la scelta che ho fatto io). Hai diritto a tutti gli 
aggiornamenti, ma se smetti di comprarlo ogni anno, devi disinstallare la 
versione che non vuoi aggiornare e reinstallare la versione che avevi prima 
dell'acquisto; l’acquisto del solo Update Pass è possibile solo se possiede 
già una licenza Perpetual; l’Update Pass sarà l’aggiornamento dell’edizione 
PRO o EX della Perpetual già posseduta; 

 continui con un abbonamento, non cambia niente e hai il programma 
aggiornato. 

 

Licenze in abbonamento 
Al momento si può anche acquistare una licenza in abbonamento valida 

per un solo disposititivo (Win, macOS, iPad, iPhone, Galaxy, Android o 
Chromebook) oppure fino a due dispositivi, fino a quattro dispositivi  o per 
un singolo smartphone (iPhone, Galaxy o Android), con possibilità di paga-
mento mensile o annuale. Alla pagina tinyurl.com/mr756zve si possono ve-
dere le varie combinazioni e il loro prezzo.  

Per chi ha già una licenza Perpetual (ad esempio una EX per PC/Mac) e-
siste una scontistica dedicata se si vuole avere il programma anche su altri 
dispositivi, vedi tinyurl.com/bdec2fbd.  

In futuro, con l’uscita delle nuove versioni, questo sistema garantirà di 
avere il programma sempre aggiornato senza dover acquistare nulla, se 
non l’abbonamento, appunto. 

 

Ho visto che c’è un aggiornamento disponibile: è a pagamento? 
Con l’introduzione della v. 2 gli aggiornamenti non sono più gratuiti.  
Per avere il programma aggiornato, con eventuali nuove funzioni e ca-

ratteristiche, bisogna o acquistare un Update Pass annuale o utilizzare il 
programma in abbonamento. Va da sé che tutti gli aggiornamenti che e-
scono durante l’anno di durata dell’UP o durante la validità 
dell’abbonamento sono compresi. Vedi le domande precedenti. 

  

Ho cambiato/formattato il PC: posso installare CSP nuovamente o la li-
cenza non è più valida? 

Installando CSP su un nuovo PC (o dopo averlo formattato), bisogna di-
sattivare la licenza eventualmente in eccesso (vedi domanda precedente). 
Se non lo si fa, dovrebbe apparire un messaggio nel nuovo computer, con  
le istruzioni per disattivare la licenza in eccesso. Vedi anche questo post, 
tinyurl.com/2p8fstmb, in cui è spiegato che effettuando il login prima di inse-

https://tinyurl.com/mr756zve
https://tinyurl.com/bdec2fbd
https://tinyurl.com/2p8fstmb
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rire il codice di attivazione, il programma riconosce che si è in possesso del-
la licenza valida. 

 

Con l’Update Pass cosa succede? 
All’avvio, il programma fa un controllo in Internet per verificare la licen-

za. In caso di controllo non riuscito, il programma si avvia con funzionalità 
limitate. 
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Versioni 

Come accennato a pag. 9 del libro cartaceo, utilizzo arbitrariamente una 
nomenclatura (“edizioni”) che nel linguaggio comunemente utilizzato tra gli 
utenti di CSP non è presente. Lo faccio solo per dare un riferimento univo-
co a ciò di cui si sta parlando, in modo da non generare fraintendimenti. 
Colloquialmente, ci si riferisce a “versioni” sia per edizioni DEBUT/PRO/EX 
che per le release. 

 

Se ho l’edizione  PRO e voglio passare alla EX devo pagare il prezzo inte-
ro? 

No, per il passaggio dalla PRO alla EX (o dalla DEBUT alla PRO) esistono 
degli sconti, consultabili alle pagine tinyurl.com/ynh4348k o tin-
yurl.com/5fd9wnfn. Vedi anche il capitolo precedente. 

 

Cosa c’è di diverso nella v. 2? 
A mio modo di vedere le differenze più importanti nella v. 2 sono rap-

presentate dalle diverse modalità di fruizione del programma. Credo che il 
cambio di versione sia stato voluto soprattutto per questo, ma comunque 
ci sono molte nuove funzioni, eccone alcune: 

 

 una di quelle che attendevo di più, e di cui ho più volte segnalato a 
Celsys la mancanza, era la possibilità di spostare il Selection Launcher, 
possibilità che ora è disponibile (non penso l’abbiano introdotta grazie 
a me, ma appena uscita la nuova versione ho ricevuto una email da 
Celsys che mi avvertiva della novità che desideravo: gran customer ca-
re, devo dire!); 

 è stata introdotta una nuova palette per allineare e distribuire gli 
oggetti, la Align/Distribute palette; 

 si possono mette in posa le mani di un manichino 3D semplicemen-
te riprendendo una propria mano con una webcam o con la fotocame-
ra del dispositivo utilizzato. Muovendo la mano, il modello 3D si adatta 
in tempo reale: carino!; 

 funzione di salvataggio in background: significa che mentre il pro-
gramma fa il salvataggio automatico si può continuare a lavorare, sen-
za interruzioni; 

 inseriti numerosi modelli 3D di testa umana, modificabili; 

 funzione per inserire le ombre automaticamente, in base ai soggetti 
in scena; 

 nuovo righello prospettico per la prospettiva Fish Eye; 

https://tinyurl.com/ynh4348k
https://tinyurl.com/5fd9wnfn
https://tinyurl.com/5fd9wnfn
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 miglioramento della gestione del testo; 

 la funzione Liquify agisce su più livelli, di vario tipo; 

 fusione più realistica dei colori quando vengono miscelati con uno 
strumento tipo pennello. 
 

Nei mesi successivi all’uscita della v. 2.0.0 sono state pubblicate altre re-
lease, ciascuna delle quali ha portato in dote qualche nuova proprietà. Per 
una panoramica più completa, leggere questa pagina del sito di CSP: tin-

yurl.com/va47nt5z (in inglese), in cui sono riportate le novità per ogni relea-
se; per farsi un’idea leggere anche il post tinyurl.com/mryswwcd e guardare 
questo video esplicativo tinyurl.com/74v3vz6x (in inglese). 

 

Cosa c’è di diverso nella v. 3? 
La v. 3 è sostanzialmente simile alle versioni precedenti, ma con qualche 

nuova funzione, tra cui: 
 

 miglioramenti nella gestione degli oggetti 3D; 

 funzione Layer comps per registrare e richiamare più combinazioni 
diferenti di livelli per cui, avendo versioni dello stesso lavoro si può 
passare da una all'altra in velocità, ed esportarle; 

 aggiunte alcune migliorie alla funzione Mesh transformation; 

 nuovi filtri e funzione Color Adjust per modificare l'atmosfera di un 
disegno in base a un'altra immagine; 

 testo su cerchio e altre funzionalità dello strumento testo; 

 introduzione di un font creato appositamente per CSP, utilizzabile 
liberamente;  

 alcune nuove funzioni per l'animazione, come l'Audio scrubbing e 
l'esportazione di gif animate con trasparenza. 
 

Una panoramica sulle novità può essere letta all’indirizzo tin-

yurl.com/3ufrj2c5. Ogni release comunque si distingue per novità e aggiu-
stamenti; come visto è possibile controllare quali modifiche vengono ap-
portate ogni volta. 

 

Scaricare una vecchia versione 
Se per qualsiasi motivo dovesse servire una vecchia versione del pro-

gramma, nel sito di Clip Studio Paint, in questa pagina, 
www.clipstudio.net/en/oldversion/ si possono scaricare le versioni superate. 
Di seguito metto i link alle versioni che sono immediatamente scaricabili 
dalla pagina al momento in cui scrivo questo paragrafo (31/01/2023); sem-
brerebbe che le versioni precedenti a queste non ci siano, ma invece co-

https://tinyurl.com/va47nt5z
https://tinyurl.com/va47nt5z
https://tinyurl.com/mryswwcd
https://tinyurl.com/74v3vz6x
https://tinyurl.com/3ufrj2c5
https://tinyurl.com/3ufrj2c5
www.clipstudio.net/en/oldversion/
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piando il link e modificando opportunamente i numeri nelle stringhe si rie-
sce a risalire anche ad altre release. Notare che, nell'ultima parte del link, w 
significa Windows e m significa macOS.  

 

Win 
www.clipstudio.net/gd?id=csp-install-win-old  
vd.clipstudio.net/clipcontent/en/lib/clipstudio/paint/data/154/CSP_154ENw_a

pp.zip  
vd.clipstudio.net/clipcontent/paint/app/1911/CSP_1911w_setup.exe  
 

macOS  
www.clipstudio.net/gd?id=csp-install-mac-old  
vd.clipstudio.net/clipcontent/paint/app/11012/CSP_11012m_app.pkg  
vd.clipstudio.net/clipcontent/paint/app/1911/CSP_1911m_app.pkg  
vd.clipstudio.net/clipcontent/en/lib/clipstudio/paint/data/154/CSP_154ENm_

app.dmg 
 

Quali differenze ci sono tra le edizioni DEBUT/PRO/EX? 
Le differenze tra le edizioni riguardano essenzialmente la possibilità di 

creare file multipagina, la possibilità di convertire modelli 3D in 2D e di cre-
are animazioni superiori a 24 fotogrammi (possibili con la EX).  La DEBUT 
inoltre non permette di disegnare in vettoriale e di personalizzare gli stru-
menti.  

La DEBUT è l’edizione che si trova talvolta in bundle quando si acquista 
una tavoletta grafica, con funzioni e durata della licenza limitate; sul sito 
Celsys (tinyurl.com/ynh4348k) si trovano solo la PRO e la EX, e gli upgrade da 
una edizione all’altra (non ho trovato in vendita la DEBUT sul sito). 

Per una lista generale delle differenze guarda tinyurl.com/3a4yvk4p, per 
una lista dettagliata guarda tinyurl.com/5hyf29zr (in inglese). 

 

Quale versione di Clip Studio Paint possiedo? 
L’edizione di CSP in uso (DEBUT/PRO/EX) appare sempre nella Title bar 

(vedi figure alle pagg. 13 e 16 del libro); se si vuole sapere il numero della 
release andare in Help > Version information… 

 

Come faccio a sapere che è uscita una nuova release? 
Quando esce una nuova versione di CSP, all’avvio del programma appa-

re un avviso. Basta cliccarci sopra per far aprire CS, poi seguire il link giusto, 
oppure vedi la prossima domanda. 

 

È uscita una nuova release, come si fa l’aggiornamento? 
Vado sulla pagina di download del programma: 

https://www.clipstudio.net/gd?id=csp-install-win-old
https://vd.clipstudio.net/clipcontent/en/lib/clipstudio/paint/data/154/CSP_154ENw_app.zip
https://vd.clipstudio.net/clipcontent/en/lib/clipstudio/paint/data/154/CSP_154ENw_app.zip
https://vd.clipstudio.net/clipcontent/paint/app/1911/CSP_1911w_setup.exe
https://www.clipstudio.net/gd?id=csp-install-mac-old
https://vd.clipstudio.net/clipcontent/paint/app/11012/CSP_11012m_app.pkg
https://vd.clipstudio.net/clipcontent/paint/app/1911/CSP_1911m_app.pkg
https://vd.clipstudio.net/clipcontent/en/lib/clipstudio/paint/data/154/CSP_154ENm_app.dmg
https://vd.clipstudio.net/clipcontent/en/lib/clipstudio/paint/data/154/CSP_154ENm_app.dmg
https://tinyurl.com/ynh4348k
https://tinyurl.com/3a4yvk4p
https://tinyurl.com/5hyf29zr
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www.clipstudio.net/en/dl/, clicco sul pulsante del sistema operativo desi-
derato, scarico il programma e lancio l’installazione.  

Non occorre disinstallare la vecchia versione; tutte le impostazioni do-
vrebbero essere mantenute, ma se si ha timore che qualcosa possa essere 
perso, è bene fare un backup prima dell’aggiornamento. Le modalità di ba-
ckup sono descritte nel testo cartaceo. 

 

Dopo un aggiornamento è sparita l’icona di CSP. Cosa devo fare per 
farla riapparire? 

Tasto destro sull'icona a desktop di Clip Studio > Proprietà > Apri percor-
so file. Così facendo ci si ritrova nella cartella di installazione di CS, CLIP 
STUDIO. Salire di una cartella, arrivando alla cartella CLIP STUDIO 1.5. En-
trare nella cartella CLIP STUDIO PAINT, dove si trova l'eseguibile di CSP. Ta-
sto destro > Invia a >  Desktop (crea collegamento). 

 
  

https://www.clipstudio.net/en/dl/
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Preferences (Preferenze) 

Un’altra parte del programma con cui è bene prendere confidenza è 
quella relativa alle impostazioni generali del programma, Preferences, le 
preferenze.  

Si tratta di impostazioni generali che in teoria bisognerebbe regolare 
prima di iniziare a lavorare con CSP, perché determinano il comportamento 
del programma nel suo insieme. Ciò non toglie che le varie impostazioni 
possano essere modificate in qualsiasi momento. 

Non tratto tutte le opzioni, ma provo a dare una panoramica di quelle 
che utilizzo o di cui conosco direttamente gli effetti (o che, redigendo il pa-
ragrafo, ho scoperto io stesso, mi hanno incuriosito e penso sia utile sapere 
cosa sono).  

Ricordo che la trattazione è relativa a CSP in ambiente Windows. Alcune 
delle opzioni possono differire in ambiente MacOS o in tablet/cellulari. Nel 
dubbio, consultare la User guide, anche se, come diverrà chiaro usando il 
programma, non è aggiornata ad ogni release  di CSP, per cui alcune delle 
opzioni che ho trovato in Preferences (al momento in cui scrivo questo pa-
ragrafo) non sono ancora state introdotte nella guida online. 

 

La finestra Preferences è attivabile da File > Preferences, oppure con la 
combinazione CTRL + K, oppure ancora portandone l’icona nella Command 
Bar e lanciandola da lì (vedi a pag. 13 e 16 del libro). Sulla sinistra trovo, in-
colonnati, i vari ambiti su cui posso andare a operare, mentre nella parte 
destra, più ampia, la relativa scheda con le opzioni disponibili. 

 

Di seguito, per alcuni esempi indico lo stilo della tavoletta grafica. Ov-
viamente lo stilo non è l'unico mezzo di input per interagire con CSP: c'è 
il sempiterno mouse e anche le dita, nel caso dei dispositivi touch. Tran-
ne quando escludo l'uso di altri mezzi o dove non lo chiarisco esplicita-
mente, lo stilo va inteso come intercambiabile con il mouse o le dita. 

 

Tools 
Switch tool temporarily 

Se la casellina Switch tool temporarily by pressing and holding shortchut 
key ha la spunta, significa che è abilitata la funzione che permette di passa-
re a un altro strumento, temporaneamente, tenendo premuto un tasto di 
scelta rapida assegnato a quello strumento.  

Per me, data la terminologia usata altrove in CSP, più propriamente si 
dovrebbe parlare di  Modifier Key, non di Shortcut Key; per l’assegnazione 
di Shortcuts e Modifier Key vedi a pag. 167 del libro. 
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Length of keypress to switch tools è il tempo necessario per passare allo 
strumento temporaneo. 

 

Options 
Minum drag distance è la distanza per cui bisogna trascinare il cursore 

perché il programma capisca che si sta effettuando un trascinamento 
(Drag) 

Auto scroll at edge of Canvas: come si comporta il cursore quando rag-
giunge il bordo del Canvas: spostando il cursore oltre il margine del Canvas, 
il Canvas sta fermo (None), oppure spostando il cursore oltre il Canvas cau-
sa il movimento del Canvas in modo da seguire il cursore (Drag e Drag with 
mouse: non trovo differenze tra questi due!),  

Figure tool guidelines: tipo di visualizzazione in anteprima quando si uti-
lizza lo strumento Direct draw. Nelle versioni più recenti questa voce non 
c’è ed è stata trasferita nella successiva Drawing tool. 

Handle size: dimensione dei punti di controllo, o maniglie. 
 

Per le altre opzioni basta tradurre quanto scritto o consultare la User 
guide cercando Preferences.  

 

Drawing tool 
Varie opzioni di visualizzazione mentre si utilizzano gli strumenti del 

gruppo Figure; sono di facile interpretazione per cui non mi soffermo, ba-
sta tradurre quanto scritto o consultare la User guide cercando Preferen-
ces. Forse l’unica degna di nota è Preview lines by pressing modifier key 
(Shift) che, se spuntata, permette di far vedere un’anteprima della linea 
retta che verrà creata quando, con un pennello, si preme contemporanea-
mente il tasto Shift. 

 

Fare attenzione alla voce Figure > Confirm shape with double-click or 
double-tap, che non fa riferimento a tutti gli strumenti del gruppo, ma solo 
a quelli che servono a creare curve continue o poligonali, che non hanno 
virtualmente una fine, come ad es. Continuous curve o le curve di Bézier, e 
che continuano a esser tracciate fintanto che non si decide di farle termi-
nare. Con l’opzione attivata basta fare un doppio click (o un doppio tap); se 
disattivata bisogna confermare con il tasto Enter. 

 

Tablet 
Queste impostazioni differiscono a seconda che si sia in ambiente 

Windows o Mac. Utilizzando un PC, mi occupo delle opzioni relative a 
Windows. 
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Using tablet service 
Sulle differenze tra Wintab e Tablet PC consiglio la lettura di questo 

post: tinyurl.com/bdd9xw2f. 
Wintab e Tablet PC sono due tipi di driver che vengono usati per lo 

scambio di dati tra il computer e tavoletta grafica. Quando certe imposta-
zioni di CSP sembrano saltare è utile, in questi casi, provare a passare da 
uno all’altro per ripristinare la piena funzionalità, ad esempio quando il 
cursore sembra spostato rispetto alla punta dello stilo. 

 

Coordinate detection mode 
Quando Using tablet service è su Tablet PC, qui appare Use more accura-

te coordinate detection; se invece è selezionato Wintab, qui appare Use 
mouse mode in setting of tablet drive. Togliendo la spunta, possono essere 
attivate le rimanenti opzioni, ma lavorando Tablet PC, non le utilizzo. 

 

Tablet Settings 
In Input frequency è possibile scegliere la quantità di informazioni da in-

viare al computer utilizzando la tavoletta. Le opzioni sono Prefer speed (ve-
locità) o Prefer quality (qualità). Nel mio CSP questa opzione è impostata su 
Prefer speed, penso sia così di default, perché non l’ho mai toccata. Vedi 
anche questo post: tinyurl.com/ye2yh3cu, a proposito della risoluzione di un 
problema con il segno. 

 

Touch gestures 
Non essendo la mia tavoletta una “touch”, non ho indicazioni utili da 

suggerire;  tuttavia, l’utilizzo è piuttosto intuitivo. 
 

Gesture configuration 
Idem come sopra. 
 

Command 
Transform 

Se c’è la spunta, il comando Transform agirà solo sui tipi di livelli elenca-
ti; se non c’è la spunta può essere che alcune trasformazioni non funzioni-
no, a seconda del tipo di livello.  

La seconda spunta imposta il doppio click per confermare la trasforma-
zione. 
Paste 

Copiando della grafica da Illustrator a CSP, questa viene convertita in li-
nee vettoriali o in immagini raster, a seconda di ciò che è selezionato nel 
menu a tendina. 

 

https://tinyurl.com/bdd9xw2f
https://tinyurl.com/ye2yh3cu
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Interface 
Impostazioni relative ai controlli IME, ai colori e altri parametri  

dell’interfaccia. 
 

IME Control 
IME significa Input Method Editor (Editor del metodo di input ); è 

un’opzione che riguarda il tipo di inserimento del testo e regola l’utilizzo 
contemporaneo di alfabeti diversi (es. giapponese e latino). 

 

Color 
Qui si imposta il “mood” generale dell’interfaccia: scuro o chiaro e quan-

to luminoso (Adjust density: sì, si chiama density, ma è come se agisse sulla 
luminosità dell’interfaccia). Io ho impostato scuro a bassa densità. 

 

Touch Operations 
Ok, c’è scritto touch, però questo parametro agisce anche se non si ha 

un dispositivo touch. Se si mette la spunta a Adjust interface for touch ope-
ration e scegliendo un Interface Scaling (e ricordandosi poi di riavviare il 
programma per rendere effettivo il cambiamento) si modificano le dimen-
sioni di icone e palette. Capita che, installando un aggiornamento (vedi a 
pag. 262 del libro), queste dimensioni cambino e qui è dove rimetterle a 
posto. In realtà, il parametro serve per dare le dimensioni  ottimali per la-
vorare anche con le dita avendo un sistema touch. 

Cambiando le impostazioni in Touch Operations si resetta anche il wor-
kspace utilizzato. Prepararsi quindi a un’eventuale rottura di scatole per ri-
pristinare le proprie impostazioni; purtroppo non serve a nulla scegliere il 
proprio workspace in Window > Workspace.  

Il percorso descritto esiste per PC, mentre in Mac questa opzione non 
c’è. 

 

Layout 
Mettendo la spunta a Switch to tablet interface si passa a un layout del 

programma ottimizzato per tablet; senza spunta il programma è ottimizza-
to per computer. 

 

Performance 
Analogamente ad altri programmi, qui si regolano quante e quali risorse 

del computer siano destinate al funzionamento di CSP. 
 

Memory 
Qui si stabilisce il percorso della memoria virtuale e quanta percentuale  

destinarne al programma. 
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Undo 
Per impostare quanti livelli di undo e quanto tempo, in millisecondi, de-

ve passare tra un’azione e un’altra perché il sistema le riconosca come due 
azioni separate (e quindi l’undo agisca su di loro separatamente e non con-
tandole come singola azione: ad esempio, se faccio dei tratteggi veloci, se 
l’intervallo è 0 allora ogni tratto sarà considerato individualmente, ma se 
aumento l’intervallo, tutti i tratti che riesco a disegnare in quel lasso di 
tempo verrano considerati come una sola azione, e l’undo li cancellerà tutti 
assieme). 

 

Ailia SDK 
Per scegliere quale processore utilizzare per alcune funzioni, come 

l’Hand Scanner. 
 

Cursor 
Per decidere la forma del cursore.  
 

Shape of cursor 
Il cursore è impostabile per ogni tipologia di strumento: pennello, pen-

na, gomma, figura, riempimento, vista, correttore; aprendo il menu a ten-
dina si trova l’elenco dei tipi di cursore disponibili, che corrispondono a 
quelli che si vedono in questa pagina della User guide: tinyurl.com/msakazre. 
Non tutti i tipi di cursore sono disponibili per ogni tipo di strumento. 

 

Additional display when brush-size cursori s small 
Quando la dimensione è troppo piccola e non è possibile visualizzare la 

grafica scelta, si può scegliere il tipo di rappresentazione del cursore. 
 

Display position for reversed cursors 
Non capisco molto il nome che hanno dato a questa opzione: non so co-

sa significhi reversed cursor* ma, a ogni modo, l’effetto che si ottiene im-
postando il radio button su Delay for stabilization è un rallentamento della 
velocità del cursore rispetto alla velocità con cui ci si muove realmente sul 
Canvas, cosicché il cursore segue lo stilo (nel caso si adoperi la tavoletta 
grafica) con un ritardo dipendente dal valore della stabilizzazione. Dalle 
prove che ho fatto, se si disegna col mouse questo effetto non è visibile. 

 

*cercando un po’ nelle FAQ del supporto Celsys, ho trovato che un fat-
to noto è che con certe tavolette usando nel parametro Angle, nella 
punta dello strumento, l’opzione Pen tilt, il cursore risulta rovesciato. La 
soluzione a questo problema comunque non riguarda il parametro trat-

https://tinyurl.com/msakazre
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tato in questo paragrafo, per cui non credo sia questo il significato che si 
dà qui a reversed cursor. 

 

Cursor details 
Cursor Options 

Come cambia l’aspetto del cursore mentre si sta disegnando. 
 

Layer/Frame 
Una serie di impostazioni per i livelli e le vignette. 
 

Layer 
Name of copies è il nome da dare al nuovo livello quando lo si crea du-

plicandone uno esistente. 
La spunta Use [Through] blending mode for new layer folders serve a 

impostare in modo Through (= attraverso) ogni nuovo Layer folder creato. 
Trovo questa opzione molto utile, perché se non si imposta questo blen-
ding mode (vedi a pag. 185 del libro) a una cartella contenente dei livelli, 
eventuali blending mode applicati su livelli superiori, al di fuori della cartel-
la, non avranno effetto sui livelli contenuti nella cartella stessa. Prima 
dell’introduzione di questo parametro spesso dimenticavo di passare la 
cartella a Through, ora lo fa in automatico. Per i vari Blending mode e i loro 
effetti vedi a pag. 31 di queste Risorse. 

Opacity of selection layers imposta la trasparenza dei livelli selezione. 
Vector path opacity imposta la trasparenza dei tracciati vettoriali, che 

vengono visualizzati ad esempio quando tocco una linea vettoriale con O-
bject. 

How to scale down screentones imposta come visualizzare un’area ri-
empita coi retini quando il Canvas è rimpicciolito. Show tone mantiene il 
retino, ma si può creare del moiré (fenomeno di interferenza, vedi anche 
tinyurl.com/2p96p2uk e tinyurl.com/3a7xwne8); Show gray cambia la visualiz-
zazione a grigio. 

 

Mask. Imposta colore, trasparenza e visualizzazione dei Layer mask (vedi a 
pag. 53 del libro) 

 

Frame Border. Imposta gli spazi (gutter) verticali e orizzontali tra le vignette 
quando vengono create dividendo lo spazio con Divide Frame border / fol-
der (vedi pag. 71 del libro), e se mascherare o meno l’area attorno alle vi-
gnette (vedi a pag. 69 del libro). 
 

 
 

https://tinyurl.com/2p96p2uk
https://tinyurl.com/3a7xwne8
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Animation 
Al momento in cui scrivo, questa voce delle Preferences non è ancora 

stata inclusa nella User guide e non essendo un esperto di animazione sono 
andato un po’ a intuito. Consiglio comunque di fare ulteriori approfondi-
menti. 

 

Animation folder 
Come incollare su un cel, se nel livello selezionato o creando un nuovo 

livello all’interno del cel. 
 

Timeline 
Automatically extend clip length fa aumentare automaticamente la lun-

ghezza di una clip quando aumento i fotogrammi nella timeline (vedi pagg. 
63 e  64) 

 

When registering light table 
Colore e opacità del light table laye. 
 

Overall light table opacity 
Opacità complessiva del tavolo luminoso. Credo sia in relazione all’icona 

Switch opacity target between All or Individual, nella Property bar della 
palette Animation cels. 

 

Camera path/Camera 
Camera path 

Show these layers. Imposta quando mostrare i tracciati dei movimenti di 
camera. 

Color; Opacity. Imposta il colore e l’opacità del tracciato. 
Show field guides. Mostrare il riquadro del campo dei soli keyframe o di 

ogni fotogramma. 
Display in different colors. Evidenziare con colori diversi il primo e 

l’ultimo fotogramma, con i colori impostati nelle caselline apposite. I foto-
grammi intermedi dovrebbero avere un gradiente di opacità (che franca-
mente non riesco ad apprezzare). 

Show lines. Mostra i riquadri dei campi nei diversi fotogrammi con delle 
linee che ne uniscono i vertici, oppure non mostrare queste linee ma una 
linea che unisce i centri di rotazione dei campi. 

 

2D camera 
Evidenzia il riquadro del campo nel fotogramma selezionato con il colore 

e l’opacità qui impostati. 
 

Show all field guides 
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 Imposta colore e opacità dei tracciati per i fotogrammi selezionati nella 
palette Timeline. Questo secondo la User guide, ma questo parametro pro-
prio non riesco a utilizzarlo. 

 

Ruler/Unit 
Ruler/Grid/Crop mak 

Per impostare il colore dei ruler attivi e non, della griglia, dei segni di ta-
glio, della gabbia e del Safety margin, nonché la loro trasparenza. 

When snapping to perspective ruler, reset drawing direction by returning 
to start point. Mentre si usa un ruler prospettico, se questa casella è spun-
tata, tornando con il cursore lungo il ruler verso il punto di partenza (con lo 
stesso tratto, ossia senza staccare lo stilo dalla tavoletta o senza sollevare il 
pulsante sinistro del mouse), il segno tracciato finora scompare e ricomin-
cia ad apparire, sempre dallo stesso punto di partenza, ma nel verso oppo-
sto. Complicato? Meglio fare una prova per rendersene conto. Io preferisco 
lasciare questa casellina senza spunta. 

 

Unit 
Per cambiare l’unità di misura delle lunghezze da px a mm o viceversa, e 

l’unità di misura dei testi da pt (punti) a Q (Quarter) o viceversa. L’effetto 
più evidente del cambiamento delle unità di misura delle lunghezze è che 
le dimensioni dei pennelli, riportate sotto le anteprime nella palette Brush 
size, si modificano, così come le dimensioni presenti nella Tool property. I 
righelli laterali non cambiano visualizzazione; per far ciò, bisogna impostare 
l’unità di misura al momento della creazione di un nuovo documento oppu-
re, se il documento è già aperto, andare su Edit > Change Canvas Size… e 
scegliere un’altra unità di misura. 

 

Canvas 
View 

Display quality. Per aumentare la qualità della visualizzazione. Due op-
zioni, Default e High quality. 

Transparent. Le aree trasparenti sono indicate da una scacchiera colora-
ta a quadratini bianchi e grigi (visibile se il livello Paper è spento): qui si 
possono modificare questi colori. 

 

Scale. Sono i valori predefiniti di zoom quando si utilizza per zoomare o il 
Navigator o con View > Zoom In/Out oppure con i comandi zoom del Can-
vas control.      

Si possono aggiungere, togliere o cambiare i valori. Revert riporta la lista 
ai valori di default. 

 



25 
 

Angle. Incrementi di angolo quando si effettua la rotazione del Canvas col 
Navigator o con i comandi di rotazione del Canvas control. 

 

 
 

Display resolution. Trovo questa funzionalità molto simpatica oltre che uti-
le: serve a calibrare la risoluzione del proprio monitor (o tavoletta); inziare 
cliccando su Settings. Nella finestra che appare ci sono una slider e un ri-
ghello. Prendere un vero righello centimetrato e sovrapporlo a quello vir-
tuale nella finestra; con i controlli dello slider far combaciare i due righelli. 
Quando le misure sono le stesse, si scopre a che risoluzione sta lavorando il 
proprio monitor, o la propria tavoletta. 

Questa cosa può non sembrare importante, ma lo può diventare se sto 
cercando di capire quanto sarà grande, una volta stampato, il mio docu-
mento. Ho trovato un chiarissimo video che spiega la cosa, tin-

yurl.com/ynudjttw; è in inglese, ma si capisce molto bene e inoltre si posso-
no attivare i sottotitoli. 

 

Analogamente all’esempio del video, se faccio la calibrazione, poi creo 
un documento, ci disegno sopra e infine vado su View > Print size, il docu-
mento scala mostrandosi a schermo esattamente grande quanto lo sarà la 
stampa. Utile! Attenzione: valido per lo schermo su cui si fa la calibrazione. 

 

 
 

File 
Auto-Recovery 

Importante! Qui si imposta l’intervallo di auto-salvataggio, in minuti. 
Utile in caso di crash del programma, black-out ecc. 

 

Save 
Save file as backgroung process permette il salvataggio in background, 

evitando di far interrompere il lavoro quando l’operazione può durare 
qualche secondo. Funziona solo quando si utilizza il comando Save e non 
con Save as o Save Duplicate. 

 

https://tinyurl.com/ynudjttw
https://tinyurl.com/ynudjttw
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Se è spuntata la casellina Show save status as pop-up, quando il docu-
mento viene salvato appare sullo schermo, al centro del Canvas, in alto, un 
pop up con la scritta Saved. 

 

 
 

La spunta su Use layer cache when exporting permette di velocizzare 
l’esportazione o il salvataggio dei file. 

 

Import IllustStudio document (xpg )/ ComicStudio page file (cpg) 
IllustStudio e ComicStudio sono due vecchi programmi di Celsys, dalla 

cui unione è nato CSP. Questi sono dei parametri per importare documenti 
realizzati con questi software. Non ci dedico spazio, qualcosa si trova nella 
User guide, sempre cercando Preferences. 

 

Page Management 
Auto save when switching page. Quando si passa a un altro documento 

automaticamente salva il lavoro sul documento precedente. Credo che 
funzioni solo con documenti facenti parte della stessa pubblicazione (un 
documento multipagina, quindi), non con due documenti aperti ma che 
non hanno nulla in comune tra loro. 

Always open in a new tab when doble-clicking or tapping to open a 
page. Se spuntato, passando a una nuova pagina (di un documento multi-
pagina), questa viene aperta in una nuova finestra; se non è spuntato, la 
nuova pagina prende il posto della precedente. 

 

File details 
PNG 

Per impostare il livello di compressione dei file .png . 
 

Compatibility mode.  Serve a consentire la compatibilità dei file .clip e .cmc 
tra versioni diverse di CSP. In particolar modo, salvare in Compatibility mo-
de può evitare che un file aperto in versioni successive da quella con cui è 
stato realizzato venga visto in sola lettura. L’utilizzo di questa opzione au-
menta le dimensioni e il tempo di salvataggio del file. 

 

Color conversion 
Settings of color conversion 

Qui si impostano i profili colore RGB e CMYK e come deve avvenire la 
conversione tra i due sistemi. Se non si hanno già le idee chiare su questo 
argomento e non si sa già quali profili utilizzare, perché indicati, ad esem-
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pio, dall’editore, consiglio di fare una ricerca nel gruppo FB CSP Italia ed 
eventualmente chiedere lumi. 

 

Edit text 
Edit text è il nome dato a due insiemi di comandi in CSP, uno presente 

nelle Preferences, trattato qui, e uno nel menu Story (vedi nel libro). Ri-
guardano entrambi la gestione del testo dallo Story Editor. 

 

New text 
How to insert new text. Se il nuovo testo va creato su un nuovo livello o 

aggiunto nel livello (di testo) preesistente. 
New text property. Selected text tool property prende le impostazioni 

dalla Tool property dello strumento testo; Copy from current text invece 
prende le impostazioni dal testo che è già presente nel documento. 

 

Line breaks/Spacing 
Impostazioni relative allo Story Editor (vedi nel libro). 
 

How to show line break. Come visualizzare le interruzioni di riga. Show 
line break interrompe la riga nella posizione indicata; Show symbol only 
mostra, nello Story Editor, solo un simbolo dove verrà interrotta la riga, ma 
ciò avverrà solo nel testo sul Canvas. 

Paragraph breaks. Come dividere il testo premendo Enter (Invio).  
No paragraph breaks. Il testo non viene diviso premendo Enter.  
Single line space. Premere Enter per dividere il testo.  
Double line space. Premere due volte Enter per dividere il testo.  
Triple line space. Premere tre volte Enter per dividere il testo. 
 

View. Anche queste sono impostazioni relative allo Story Editor (vedi nel li-
bro), e riguardano i testi per come appaiono nello SE, non come appaiono 
sul Canvas (cioè sulla tavola a fumetti). 

 

Direction Horizontal / Vertical. Se nello Story Editor il testo verrà visua-
lizzato orizzontalmente o verticalmente. 

Main text font. Carattere principale e sua dimensione. È il carattere con 
cui si scrive nello Story Editor. 

 

Reading text font. Inserisco una 
parola con lo strumento testo nel 
Canvas, cioè nella tavola: 
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poi seleziono le lettere che la 
compongono: 
 

 
Vado in Sub Tool Detail > Reading > Setting for reading > Reading set-

ting, dello strumento testo: 
 

 

 
 

Si apre una finestra 
di inserimento: 
 

 
 

In Reading string 
digitare un altro te-
sto: 
 

 
 

e dare l’invio. 
A questo punto, sopra al testo originale appare un secondo testo: quello 

inserito nella Reading string: 

 
 

Questa opzione serve a visualizzare le pronunce (è scritto nella User 
guide); comunque, quanto visto è ciò che accade sul Canvas quando decido 
di visualizzare il reading text. Ma anche nello Story Editor è possibile visua-



29 
 

lizzare il reading text e, in Preferences > Edit text > Reading font, definire 
come visualizzarlo nello Story Editor stesso. 

 

 
File > Preferences > Edit text > View 

 

 
Story Editor 

 

Quindi, File > Preferences > Edit text  > View imposta i caratteri nello 
Story Editor, mentre i caratteri visualizzati nel fumetto possono essere im-
postati da Story > Edit text > Story Editor (vedi nel libro). 

 

3D 
Model settings. Impostare il modello 3D di default. 

 

Rendering settings 
Use multi-sampling. Aumenta la qualità del render 3D. 
 

Import settings for Wavefront OBJ files 
Impostare le corrispondenze spaziali per importare  file .obj . 
 

Import settings for 3D files 
Import 3D files in format from ver.1.10.13 and earlier. Per importare file 

3D nel formato della versione 1.10.13 o precedente. 
 

Smartphone connection 
Main device settings 

In Port. No. è impostata la porta di comunicazione tra il dispositivo prin-
cipale e il cellulare. Come dice la scritta, se viene cambiata andare sul menu 
(File, non indicato, almeno fino alla v. 2.1.4) e cliccare su Connect to smar-
tphone. Io ho lasciato tutto di default. 
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Tabmate 2 
Il Tabmate è un dispositivo di input che si può acquistare separatamente 

dal programma, una sorta di telecomando ai cui tasti si possono attribuire 
varie funzioni; vedi anche tinyurl.com/duja5ruz.  

 

Scan Settings è un’opzione che serve a individuare il dispositivo e ac-
coppiarlo al programma.  

 

  

https://tinyurl.com/duja5ruz
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Blending mode 

Di seguito come agiscono i vari metodi di fusione, come riportato dalla 
User guide. 

Con l’asterisco * indico le voci presenti solo nell’elenco dei metodi dei 
pennelli. Tra parentesi quadre e in corsivo [ ] ho indicato i corrispondenti 
comandi in Photoshop, quando hanno un nome diverso; non tutti i metodi 
esistono in entrambi i programmi;   

 

I metodi di fusione sono spiegati nel Manuale in Layer Palette > Layer 
Operations > Setting the Blending Mode. 

 

Normal  Normale 
Sovrappone il riempimento così com’è sopra il colore originale. 

 Darken   Scurisci 
I valori RGB del riempimento e il colore originale sono confrontati e viene 
mostrato il valore più basso 

Multiply  Moltiplica 
I valori RGB del riempimento vengono moltiplicati per quelli del colore o-
riginale. Dopo la fusione, i colori sono più scuri degli originali. Quando il 
colore di riempimento è bianco il colore nel layer sottostante viene mo-
strato così com’è. 

Color burn  Brucia 
Produce un effetto simile alla “bruciatura” nella fotografia tradizionale, I 
colori originali sono dapprima scuriti per aumentare il contrasto e poi uni-
ti al colore di riempimento. Quando il colore di riempimento è bianco, il 
colore originale rimane com’è. 

Linear burn  Brucia lineare 
I colori originali sono dapprima scuriti e poi uniti al colore di riempimento. 
Quando il colore di riempimento è bianco, il colore originale rimane 
com’è. 

Black burn  Bruciatura  scura * 
Scurisce l’area di disegno producendo un effetto simile alla sottoesposi-
zione in fotografia. L’effetto non viene applicato quando il colore originale 
è trasparente. 

Subtract  Sottrai 
I valori RGB del colore di riempimento sono sottratti da quelli del colore 
originale. Dopo l’unione, i colori sono più scuri degli originali. Quando il 
colore di riempimento è il nero, il colore originale rimane com’è. 

Lighten  Schiarisci 
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I valori RGB e il colore originale sono confrontati e viene mostrato  il colo-
re con il valore più alto. 

Screen  Schermo  [Scolora] 
I colori originali sono dapprima invertiti e poi moltiplicati per il colore di 
riempimento. Dopo l’unione, i colori sono più luminosi degli originali. 
Comunque, quando il colore di riempimento è il nero, il colore originale 
viene mostrato com’è. Quando il colore di riempimento è il bianco, viene 
mostrato il bianco. 

Color dodge  Schermatura colore  [Colore Scherma] 
Così come il “Dodge” nella fotografia tradizionale, rende più luminosi i co-
lori del layer sottostante diminuendo il contrasto. Quando il colore di ri-
empimento è il nero, il colore originale è mostrato com’è. 

Glow dodge   Scherma Bagliore  [Scherma] 
Produce un effetto sulle aree semitrasparenti più forte del Color dodge. 
Quando il colore di riempimento è il nero, il colore originale è mostrato 
com’è. 

White burn * 
Schiarisce  il colore sottostante, come in un effetto di sovraesposizione. 

Add  Somma 
I valori RGB del colore di riempimento vengono sommati a quelli del colo-
re originale. Dopo l’unione, i colori sono più luminosi degli originali. 
Quando il colore di riempimento è il nero, il colore originale è mostrato 
com’è. 

Add (Glow)  Somma (Bagliore) 
Sulle aree semitrasparenti produce un effetto più forte dell’Add. Quando 
il colore di riempimento è il nero, il colore originale è mostrato com’è. 

Overlay  Sovrapponi 
Unisce applicando il Multiply o lo Screen a seconda dei colori sovrapposti. 
Dopo l’unione, le aree più luminose sono ancor più luminose, le zone più 
scure ancora più scure. 

Soft light  Luce soffusa 
Produce risultati differenti a seconda della luminosità del colore di riem-
pimento. Quando il colore di riempimento è più luminoso del grigio al 
50%, il risultato è più luminoso del colore originale, come nell’effetto Do-
dge. Quando il colore di riempimento è meno luminoso del grigio al 50%, 
il risultato è più scuro del colore originale, come nell’effetto Burn. Quan-
do il colore è luminoso come il grigio al 50% il colore originale non viene 
modificato. 
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Hard light  Luce forte Luce intensa 
Produce effetti differenti a seconda della luminosità del colore di riempi-
mento. il colore di riempimento è più luminoso del grigio al 50%, il risulta-
to è un colore luminoso che assomiglia a quello dell’effetto Screen. Quan-
do il colore di riempimento è meno luminoso del grigio al 50%, il risultato 
è un colore che ricorda quello dell’effetto Multiply. Quando il colore è 
luminoso come il grigio al 50% il colore originale non viene modificato. 

Difference  Differenza 
Sottrae il colore di riempimento dal colore originale e sostituisce il colore 
originale con il valore assoluto della differenza. 

Erase (ex Clear)  Pulisci Cancella * 
Il disegno è cancellato nell’area riempita 

Background  Sfondo * 
Mette il colore di riempimento sotto il colore originale. Il colore di riem-
pimento si comporta come se fosse applicato per primo. 

Replace alpha  Sostituisci alfa * 
Sovrappone il colore di riempimento al colore originale. L’opacità 
dell’area sovrapposta è convertita nell’ Opacity specificata nella finestra 
di dialogo.  

Compare density  Confronta la densità * 
Riempie solo quando l’opacità del colore di riempimento è maggiore di 
quella del colore originale. 

Erase (compare)  Cancella (confronta) * 
Cancella il disegno solo quando il risultato della sottrazione dell’opacità 
del riempimento da 100 è più piccolo dell’opacità del colore originale. 

Vivid light  Luce vivida 
Il contrasto è rafforzato o indebolito a seconda del colore di riempimento. 
Se il colore di riempimento è più brillante del grigio al 50%, è applicato il 
Brucia e l’immagine è resa più luminosa. Se è più scuro del grigio al 50%, è 
applicato il Dodge e il contrasto dell’immagine aumenta. 

Linear light  Luce lineare 
La luminosità è aumentata o diminuita a seconda del colore di riempi-
mento. Se il colore di riempimento è più luminoso del grigio al 50% 
l’immagine è resa più luminosa. Se è più scuro del grigio al 50%, 
l’immagine è resa più scura. 

Pin light  Luce puntiforme 
I colori dell’immagine sono sostituiti a seconda del colore di riempimento. 
Se il colore di riempimento è più luminoso del grigio al 50%, il colore ori-
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ginale è sostituito dal colore di riempimento solo se il colore originale è 
più scuro. Se il colore di riempimento è più scuro del grigio al 50%, il colo-
re originale è sostituito dal colore di riempimento solo se il colore origina-
le è più chiaro. 

Hard mix  Miscela dura 
I valori RGB del colore di riempimento sono sommati a quelli del colore 
originale. Se il totale di uno dei valori RGB è maggiore di 255, è convertito 
a 255. Se il totale di uno dei valori RGB è minore di 255, è convertito a 0. 

Exclusion  Esclusione 
Un effetto simile a Difference, tranne che per un contrasto minore. Se il 
colore di riempimento è il bianco, il colore dellayer sottostante è invertito 
quando avviene la fusione. Quando il colore di riempimento è il nero, il 
colore originale rimane com’è. 

Darker color  Colore più scuro 
 La luminosità del colore di riempimento e quella del colore originale ven-
gono confrontate ed è mostrato il colore con il valore più basso. 

Lighter color  Colore più chiaro 
La luminosità del colore di riempimento e quella del colore originale ven-
gono confrontate ed è mostrato il colore con il valore più alto. 

Divide  Dividi 
I valori di RGB del colore originale sono moltiplicati per 255 e poi divisi 
per I valori RGB del colore di riempimento. 

Hue  Tonalità  
È applicata la tonalità del colore di riempimento, mantenendo la lumino-
sità e la saturazione del colore originale. 

Saturation  Saturazione  
È applicata la saturazione del colore di riempimento, mantenendo la lu-
minosità e la tonalità del colore originale. 

Color  Colore 
Sono applicate la tonalità e la saturazione del colore di riempimento e 
viene mantenuta la luminosità del colore originale. 

Brightness Luminosity  Luminosità  [Luminosity] 
È applicata la luminosità del colore del riempimento mantenendo la tona-
lità e la saturazione del colore originale. 
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Unità di misura 

Dpi e mm 
Dpi significa dots per inch, ovvero punti per pollice, ed è una unità di mi-

sura utilizzata in stampa che si riferisce al numero di punti che una stam-
pante rilascia in una lunghezza di 1 pollice, cioè circa 2,54 cm. 

Nelle imagini digitali teoricamente si dovrebbero usare i ppi, points per 
inch, poiché fanno riferimento al numero di pixel allineati in un pollice di 
un’immagine, ma nell’uso comune i ppi vengono assimilati ai dpi, anche se 
non sono la stessa cosa; anche CSP utilizza questa semplificazione. Vedi an-
che l’articolo “Differenza tra DPI e PPI”, tinyurl.com/y3u5wzp3. 

 

A quanti pixel deve corrispondere, a una data risoluzione, una misura 
che ho in cm o mm? A quanti mm o cm corrisponde un dato numero di 
dpi a una certa risoluzione? Ecco un paio di esempi. 

 

 A 600 dpi quanto deve misurare in pixel lo spazio tra le varie vignette, 
considerando che utilizzo 5mm tra le righe e 4 mm tra le colonne? 

 

600 dpi = 600 punti per pollice = 600 punti ogni 2,54 cm = 600 punti 
ogni 25,4 mm.  

Quindi, in ogni mm ho 600/25,4 = 24 punti circa, arrotondando. 
Per 5 mm ho 24x5= 120 punti (px); sarebbero 118 se non arrotondassi; 
Per 4 mm ho 24x4= 96 punti (px); sarebbero 94 se non arrotondassi. 

 

La formuletta, in pratica, è: 
 

 

𝑑𝑖𝑚𝑒𝑛𝑠𝑖𝑜𝑛𝑒  𝑖𝑛 𝑝𝑥 =  
𝑟𝑖𝑠𝑜𝑙𝑢𝑧𝑖𝑜𝑛𝑒

25,4
× 𝑑𝑖𝑚𝑒𝑛𝑠𝑖𝑜𝑛𝑒  𝑖𝑛 𝑚𝑚  

=   
𝑟𝑖𝑠𝑜𝑙𝑢𝑧𝑖𝑜𝑛𝑒

2,54
× 𝑑𝑖𝑚𝑒𝑛𝑠𝑖𝑜𝑛𝑒  𝑖𝑛 𝑐𝑚  

 

 

 Ho un'immagine di dimensioni 946x1409 px a 300 dpi. Quanto grande 
è in centimetri? 

 

A 300 dpi in un pollice ( 2,54 cm) ci sono 300 punti; quindi: 
per la larghezza: 
946 pixel sono 946/300 = 3,153 pollici, ovvero 3,153 x 2,54 = 8 cm (ar-

rotondando); 
per l'altezza: 
1409/300 = 4,7 pollici, quindi 4,7 x 2,54 = 12 cm (arrotondando). 

 

 

https://tinyurl.com/y3u5wzp3
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Qui la formuletta è:  
 

 

𝑑𝑖𝑚𝑒𝑛𝑠𝑖𝑜𝑛𝑒  𝑖𝑛 𝑐𝑚 =  
𝑑𝑖𝑚𝑒𝑛𝑠𝑖𝑜𝑛𝑒 (𝑖𝑛 𝑝𝑥)

𝑟𝑖𝑠𝑜𝑙𝑢𝑧𝑖𝑜𝑛𝑒
 × 2,54 

 

 

Se volessi la dimensione in mm, la formuletta diventerebbe: 
 

 

𝑑𝑖𝑚𝑒𝑛𝑠𝑖𝑜𝑛𝑒  𝑖𝑛 𝑚𝑚 =  
𝑑𝑖𝑚𝑒𝑛𝑠𝑖𝑜𝑛𝑒 (𝑖𝑛 𝑝𝑥)

𝑟𝑖𝑠𝑜𝑙𝑢𝑧𝑖𝑜𝑛𝑒
 × 25,4 

 

 

Ho creato un piccolo foglio di calcolo per fare questi semplici trasformazioni, si 
può scaricare da tinyurl.com/ycx8x3b2. 

 

Misure e testo 
Una domanda interessante è stata posta nel gruppo Fb CSP Italia 

(tinyurl.com/e7rvxxw4): è possibile sapere quanto misura, in cm, un caratte-
re con un dato valore di grandezza?  

I caratteri si misurano in punti (pt); il punto tipografico ha un valore ben 
definito: 1 pt = 0,0352778 cm = 0,352778 mm (ed è pari a 1/72 di pollice, 
cioè 2,54 cm / 72). Grossomodo 1/3 di mm, quindi (e da cui 1 cm = 28,3465 
pt). Una successiva richiesta nello stesso post era se si debba convertire in 
pixel questa quantità.  

Nei programmi di grafica, in genere, si lavora molto con i pixel, ma chie-
dersi quanto grande è, in pixel, un carattere con una data dimensione in 
punti ha però poco senso se non so (di nuovo!) la risoluzione del documen-
to su cui sto lavorando. Posso cioè effettivamente ricavare la corrisponden-
za tra le dimensioni in pt del carattere (il corpo) e i cm, ma una volta dentro 
al file questa corrispondenza perde di significato se non tengo conto della 
risoluzione del file stesso. 

 

Il pixel, infatti, è un'entità "variabile", nel senso che le sue dimensioni ef-
fettive dipendono dalla risoluzione che sto utilizzando: un ipotetico righello 
in plastica di 10 pixel potrebbe essere lungo un millimetro oppure quattro 
centimetri (dico numeri a caso), perché il pixel come unità di misura è signi-
ficativo solo se inserito in un contesto di risoluzione, cioè se questa viene 
specificata.  

Dire cioè “questa linea è lunga 523 px” ha senso solo in relazione alle 
dimensioni in px dell’intera immagine, ma non dice nulla delle sue effettive 
dimensioni in cm o in mm. Non conoscendo la risoluzione dell’immagine 
può voler dire che la linea è piuttosto lunga oppure brevissima. Ad esem-

https://tinyurl.com/ycx8x3b2
https://tinyurl.com/e7rvxxw4
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pio, 10 pixel a 300 dpi hanno un senso: di questi dieci pixel posso sapere 
qual è la misura (nello specifico 10 px a 300 dpi sono 0,085 cm, o 0,85 mm). 

Ecco che una linea lunga 523 px a 300 dpi è lunga 4,4 cm; la stessa linea 
di 523 px a 100 dpi è lunga invece 13,3 cm, una discreta differenza. Nel 
primo caso i px sono lunghi ~ 0,084 mm, nel secondo ~ 0,25 mm, tre volte 
più grandi (notare: lo stesso rapporto tra le risoluzioni…) 

Così, potrebbe assumere significato un righello in pixel a 300 dpi, ad e-
sempio. 

 

Per semplificare, provo a immaginare che invece del sistema imperiale si 
utilizzi, per la risoluzione, il sistema metrico: concettualmente non cambia 
nulla, ma è più facile fare i calcoli. 

Una possibile risoluzione potrebbe essere, ad esempio, 100 punti per 
centimetro, li chiamo dpc (dot per centimeter). Quale sarebbe la dimensio-
ne di un pixel? Semplice: 1/100 di cm (o 1/10 di mm), dato che in un centi-
metro ci starebbero 100 px. Ma a una risoluzione di 300 dpc, un pixel sa-
rebbe 1/300 di cm (o 1/30 di mm), tre volte più piccolo. Trasferendomi nel 
sistema imperiale la cosa è analoga, solo che la mia unità base è il pollice 
(circa 2,54 cm). 

Le dimensioni “fisiche” dei pixel dipendono dalla risoluzione a cui stiamo 
operando, non c'è una corrispondenza diretta tra cm e pixel. 

 

Rispondendo alla domanda iniziale: è possibile sapere quanto misura in 
cm un carattere con un dato valore di grandezza (in pt)? 

La conversione da pt a cm è veloce, visto che c'è una corrispondenza di-
retta tra pt e cm:  

1 pt = 0,0352778 cm (0,352778 mm). 
Un testo a corpo 12 misurerà 12 x 0,0352778 = 0,4233335 cm.  
 

Se si vuol vedere a quanto corrisponde in px in un documento, deve en-
trare in gioco la risoluzione; per cui: 

misura in px = 12 pt = 0,4233335 cm = 0,4233335 x risoluzione / 2,54;  
a 300 dpi sarà: 
misura in px = 12 pt = 0,4233335 cm = 0,4233335 x 300 / 2,54 = circa 50 

px 
 

Andando a fare la prova del nove su CSP, tutto questo discorso sembra-
va doversi dissolvere.  

Ho scritto una "T" in Arial a corpo 12 in un documento a 300 dpi e sono 
andato a misurare col righello laterale l'altezza effettiva in px. Risultato: un 
po' meno di 40 px.  
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Cavoli, credevo di aver fatto un bel ragionamento...  
Poi però mi son ricordato che in Edit > Change Canvas Size... è possibile 

modificare l'unità di misura dei righelli, e l'ho cambiata in... pt! È risultato 
che il mio carattere in corpo 12 pt è in realtà poco più di 9,5 pt: ancora 
qualcosa non torna. Evidentemente nel computo totale del corpo di un ca-
rattere vengono compresi anche degli spazi, che ne riducono l'effettiva 
grandezza: si dice 12 pt, ma in realtà sono un po' meno.  

L’avevo immaginato, ma ho voluto andare a controllare: effettivamente 
è così. La dimensione del corpo non è la dimensione della lettera ma inclu-
de anche dello spazio riservato agli accenti, alle parti ascendenti o discen-
denti di alcune lettere e così via (se non fosse così, maiuscole e minuscole, 
oppure lettere come la "a", la "g" e la "f", ad es., avrebbero tutte la stessa 
altezza), e corrisponde alla dimensione del blocchetto di metallo su cui, un 
tempo, veniva fusa la lettera in rilievo.  

 

 
Il corpo e le altre misure di un carattere 

 

Sul corpo del carattere non mi dilungo oltre, se si vuol approfondire: tin-

yurl.com/3pk7anrp. 
 

Ho voluto fare un'ultima verifica: ho tracciato due linee orizzontali di-
stanti tra loro 12 pt, ho ricambiato l'unità di misura, portandola a px, e ho 
constatato che effettivamente le due righe distano tra loro 50 px:  yesss! 
Quindi è possibile sapere quanto grande è un carattere, in cm o in px, te-
nendo presente però che la misura è riferita all’ingombro totale, spazi “di 
servizio” inclusi, non al solo segno. 

 

 
A sinistra misura in pt, a destra misura in px 

  

https://tinyurl.com/3pk7anrp
https://tinyurl.com/3pk7anrp
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Dimensioni del pennello e unità di misura 
Se in Preferences  > Ruler/Unit l’unità di misura delle lunghezze (Unit of 

length) è impostata in px, la scala delle dimensioni dei pennelli arriva a 
2000; se impostata in mm arriva a 100.  

Se scelgo px come Unit of lenght, le dimensioni a schermo della punta 
del pennello dipendono dalla risoluzione del documento. Per verificarlo, fa-
re una prova:  

 in due documenti di dimensione A4, uno a 300 dpi e l’altro a 600 dpi, 
impostare px in Preferences  > Ruler/Unit > Unit of length;  

 disegnare un cerchio alla massima grandezza in ognuno dei due file; 

 impostare mm in Preferences  > Ruler/Unit > Unit of length; 

 disegnare un cerchio  alla massima grandezza in ognuno dei due file; 
 

A 300 dpi il cerchio disegnato con px (in rosso) ha un diametro di 169 
mm e quello disegnato con mm (in azzurro) ha diametro, chiaramente, di 
100 mm; a 600 dpi il cerchio disegnato con px ha un diametro di 84,5 mm e 
quello disegnato con mm ha ancora un diametro di 100 mm. Notare che al 
raddoppio della risoluzione corrisponde un dimezzamento del valore in mm 
per lo stesso valore di px. 

 

 
300 dpi  

 
600 dpi 

Sono disegnate an-
che due linee, otte-
nute mantenendo le 
stesse dimensioni con 
le due risoluzioni: la 
linea rossa è in en-
trambi i disegni di 
200 px, la linea blu di 
8 mm. 

 

Se confronto le due immagini mantenendo le rispettive risoluzioni, vedo 
che il cerchio rosso, disegnato con px e al massimo della taglia consentita 
da CSP, ha lo stesso diametro, ovvero 2000 px. 
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Clip Studio Modeler  

Clip Studio Modeler (CSM) è un programma accessorio che fa parte del-
la suite Clip Studio, scaricabile da www.clipstudio.net/en/modeler/. CSM ser-
ve a preparare dei modelli 3D per poi poterli utilizzare in CSP, ma il suo uti-
lizzo non è indispensabile. Alcuni dei modelli configurabili sono presenti nei 
Material (il programma condivide la Material palette con CSP), ma se serve 
qualcosa di particolare bisogna comunque crearlo con un programma 3D 
esterno. Una volta importato in CSM e adattato come voluto, si deve regi-
strare il modello nei Material per poterlo poi utilizzare in CSP. 

 

Per le normali esigenze, come mettere in posa un manichino da usare 
come riferimento, a mio avviso CSM è poco utile  e basta ciò che riesce a 
fare CSP.  Sono pronto a cambiare idea se avrò l’occasione di utilizzarlo di 
più, ma al momento non trovo questo programma molto intuitivo ma un 
po’ cervellotico, e credo di condividere questo pensiero con molti utenti. 

 

Esiste un manuale online, tinyurl.com/9kpfp355, per il resto il materiale 
ufficiale è piuttosto carente (alcuni tutorial: tinyurl.com/4bae4fpt, in fondo, 
che comunque rimandano al manuale); c’è inoltre chi si impegna per spie-
garne l’utilizzo, ad es. Paul Cageggi nel suo canale Youtube 
(tinyurl.com/mv5v6hr9, in inglese); qualcosa si trova anche in italiano cer-
cando nel gruppo FB CSP Italia. 

 

Giusto per non farsi prendere dallo sconforto e magari per farsi  venire 
la voglia di scoprire qualcosa in più di CSM, provo a spiegare velocemente 
come impostare un primo modello. 

 

L’interfaccia di CSM 
CSM ha un’interfaccia un po’ diversa da CSP: la struttura sembra la stes-

sa ma i contenuti sono differenti. Appena avviato appare subito la finestra 
di dialogo New, che chiede se si vuole creare un oggetto 3D oppure un per-
sonaggio 3D. Scelgo ad esempio Create 3D character. 
 

https://www.clipstudio.net/en/modeler/
https://tinyurl.com/9kpfp355
https://tinyurl.com/4bae4fpt
https://tinyurl.com/mv5v6hr9
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Al centro troviamo il Canvas, che però non contiene un foglio di lavoro, 
ma direttamente l’ambiente 3D. Sopra al Canvas ci sono la Command Bar, 
la Menu Bar e la Title bar. 

Sulla sinistra c’è la Tool palette, con gli strumenti View, Move e Texture, 
poi la Sub Tool palette e sotto la Tool properties palette. A destra il Naviga-
tor, la Character configuration palette e la Character information palette. 
Sempre a sinistra, più vicino al Canvas, ci sono i Material, che sembrano gli 
stessi di CSP, anche se l’alberatura non è esattamente la stessa. 

 

 
 

Dico sembrano, perché pur apparendo tra i Material, molti modelli non 
si riescono a trascinare nell’ambiente 3D. Moltissimi altri oggetti, presenti 
in CSP, qui non appaiono nemmeno. Qui ci si scontra con una delle caratte-
ristiche controintuitive di CSM, ovvero: è un programma per la gestione del 
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3D e sembra che ci siano dei modelli 3D a disposizione, ma molti in realtà 
non ci sono. Non si capisce poi quale sia il criterio per cui, ad es., i modelli 
Background si possano mettere in scena (tra l’altro, se trascino un 
Background in un documento di tipo character viene creato un nuovo do-
cumento object) ma un manichino 3D drawing figure no.  

Quello che penso è che in realtà la palette Material non serva come ma-
gazzino dove andare a prendere dei materiali, ma piuttosto sia un posto 
dove andare a stoccare i materiali modificati che provengono dall’esterno 
del sistema Clip Studio, tipo un programma 3D terzo.  Un veloce giro in Clip 
Studio Ask mi conferma che il programma è piuttosto limitato e non può 
editare la gran parte dei materiali  3D presenti nei Material. 

 

Creare un personaggio 
Finita questa breve presentazione dell’interfaccia, torno a costruire il 

mio personaggio. Nei Material cerco 3D > Character parts > Body. Nella co-
lonna delle anteprime vedo una serie di personaggini con  le braccia aper-
te, tutti o quasi con il simbolo della nuvoletta accanto. Quelli con la nuvo-
letta non sono ancora realmente nei Material, bisogna scaricarli dagli As-
sets.  

 

 
 

Seleziono un personaggio con la nuvoletta e lo trascino sul Canvas, ap-
pare una finestra di dialogo che chiede se si vuole scaricare il materiale da 
Clip Studio;  

 

 
 

clicco Yes  e si apre CS che in pochi istanti scarica il personaggio e dopo 
qualche altro istante la nuvoletta dell’anteprima scompare, confermando 
che il materiale è ora disponibile. Lo trascino sul Canvas e… è senza testa! 
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Vado in Material > 3D > Character parts > Face; appaiono una serie di 
volti senza alcun dettaglio, più precisamente delle forme di volto. Il nome 
di ognuno di essi è anche una breve descrizione della morfologia; ne scelgo 
uno (stesso discorso delle nuvolette…) e lo trascino sul Canvas. Automati-
camente, va a prendere posizione sul collo. 

 

 

 

 

L’ultima sottocartella di Character parts è quella relativa ai capelli (Hair): 
trascino un’acconciatura nel Canvas, che va a prendere posto sulla testa. 

 

 
 

Le operazioni appena viste si potevano effettuare anche dalla colonna di 
destra, dalla palette Character configuration. Per prima cosa seleziono dal-
la Tool palette lo strumento View; così facendo si sbloccano alcune icone 
nella palette Character configuration, sulla destra del Canvas. Per il corpo 
seleziono l’icona Body e poi l’icona Add from material che si trova nella 
parte inferiore della palette: si apre la finestra Body da cui scegliere il per-
sonaggio voluto. Analogamente si procede per la testa e i capelli, le cui ico-
ne si sbloccano dopo aver messo un corpo in scena. 
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A proposito di testa, salta all’occhio che 
il volto del nostro personaggio non ha alcu-
na caratteristica, è vuoto.  

In Material > 3D > Character texture > 
Face troviamo molte texture con cui andare 
a caratterizzare la faccia del personaggio. 
Tuttavia, se provo a trascinare una di que-
ste sul Canvas, non mi è consentito. 

Andare in Character configuration > Face 
e selezionare la cartella con il modello di 
volto applicato. 
 

 

 

 

 

 
 

 

Bisogna poi tornare alla Tool palette, 
selezionare Texture e nella Sub Tool 
palette selezionare Paste texture; trasci-
nare una texture del volto nella Tool pro-
perty, nella cartella Texture image.  

Ora si può far diventare la texture il 
volto del personaggio.  

Col cursore vado sulla testa e trascino 
un rettangolo, che applicherà la texture 
sulla faccia.  

 

Se prima spunto Same size vengono mantenute le proporzioni 
dell’immagine trascinata, diversamente le proporzioni possono essere mo-
dificate. Una volta applicata la texture la Sub tool passa a Move texture; per 
modificare Same size o applicare una texture differente tornare a Paste te-
xture. 
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Una volta posizionata la texture, selezionare View  > Camera orientation 
per muovere il personaggio e controllare se va tutto bene. 

 

 
 

 

Le texture del volto, così come le varie texture che “rivestono” le varie 
parti del personaggio, possono essere create a parte e poi applicate. Non si 
è quindi limitati alle texture presenti nel programma. 

Prima di procedere alla realizzazione di una texture personalizzata per il 
volto, se non lo si è già fatto è bene salvare il progetto con File > Save o Sa-
ve as, poiché la modifica è distruttiva. Salvando, almeno si ha una copia con 
il proprio lavoro completo. In alternativa, duplicare la cartella con il volto 
applicato in Character configuration > Face (icona Duplicate node) e lavora-
re sul doppione.  

CSM salva file con estensione .csmc . 
 

Da Character configuration selezionare l’icona Face e la cartella con il 
volto applicato; nella palette Character information mettere la spunta a 
Use facial expression texture. 

Qui arriva la parte distruttiva: il programma avvisa che se si procede, la 
texture applicata in precedenza verrà tolta e l’operazione non sarà reversi-
bile; dare l’OK. 
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Da Character configuration, con la cartella del volto selezionata, cliccare 
sull’icona Export facial expression , che farà esportare un file .psd. Que-
sto file contiene un’immagine di 1024 x 1024 px a 72 dpi dello sviluppo del-
la texture, e numerosi livelli sui quali andare a disegnare le caratteristiche 
del volto in varie espressioni. 

 

 

 

 

 Nota: alcuni livelli sono 
chiamati eye_right e e-
ye_left. Questi non fanno 
riferimento agli occhi de-
stro e sinistro, ma alla di-
rezione in cui gli occhi 
guardano.  

In eye_right, ad es., van disegnati entrambi gli occhi, che guardano a de-
stra. 

Una volta disegnato ciò che ci serve e risalvato il file, lo si può importare 
in CSM con l’icona Import facial expression . 
 

 
 
Posso infine salvare il mio personaggio nei Material. Per prima cosa 

scelgo un’immagine di anteprima, una thumbnail.  
In Character information (a 

destra in basso) c’è un’icona ge-
nerica:  

 

 

 la clicco e viene fatta una cattura 
del personaggio sul Canvas, che ver-
rà utilizzata come anteprima; 
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È possibile cambiare la visualizzazione prima della cattura, cosicché 
l’immagine sarà differente. Se l’anteprima non ci piace, modificare la visua-
lizzazione e ripetere.  

Registrare quindi il personaggio da  File > Register as new material, sce-
gliere un nome, una posizione di salvataggio e aggiungere dei tag. Dare 
l’OK per salvare. 

 

 

Ora è possibile 
inserire il personag-
gio creato in CSP, 
basta andare nella 
stessa cartella dei 
Material e trascinar-
lo nel Canvas. La po-
sa  non è quella di 
lavorazione in CSM, 
ma una un po’ più 
naturale.  

 
 
 

 

In CSP si possono applicare 
al personaggio le varie pose a 
disposizione nei Material. 
 

 

In posa con CSM 
In CSM è possibile modificare la posa del personaggio, ma le pose create 

in CSM non possono essere esportate nei Material e quindi essere utilizza-
te in CSP. 

Selezionare lo strumento Move > Bone operation; in Character configu-
ration diventa attiva la sezione Pose data. Spostarsi sulla la parte del corpo 
che si vuole muovere (diventa azzurra). 

 

 

Toccando, la 
parte diventa 
rosa e appare 
un Local Mani-
pulator.  
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 Dopo aver fatto le modifiche volute (an-
zi, forse è meglio farlo prima), andare in 
Character configuration > Pose Data, clic-
care sull’icona Add new : viene creato 
un nuovo livello New pose in cui salvare la 
posa (per comodità lo rinomino Posa 1);   

con questo selezionato, cliccare sull’icona Save character pose . 
Se ora ruoto la vista con View > Camera orientation, il personaggio torna 

alla posa di default. Per riapplicare la posa appena creata, riselezionare 
Move > Bone operation, in Character configuration selezionare Pose data > 
Posa 1 e cliccare l’icona Apply pose to character .  

Volendo, posso creare nella stessa maniera un’altra posa, Posa 2. 
 

Nella palette Character information appare la solita icona 
neutra. Nella Character configuration seleziono Posa 1, che 
viene riportata anche come nome nella Character informa-
tion. Clicco sull’icona neutra e si apre la finestra di cattura 
dell’immagine che servirà come anteprima della Posa 1. Fatta 
l’anteprima, posso aggiungere anche qualche parola di descri-
zione in Comment. 

 

 

 

 

Seleziono poi, nella Character configuration, la Posa 2; torno nella Cha-
racter information, clicco il pulsante Apply pose to Character e creo 
l’anteprima anche per questa posa. 

Alla fine delle operazioni (ogni tanto anche durante) salvo il .csmc, che 
includerà anche le varie pose. Ora ci si può chiedere a che serve perder 
tempo in CSM per salvare le pose se poi non è possibile utilizzarle in CSP. 

 

Andando a modificare le pose si possono creare dei conflitti tra le varie 
parti 3D che compongono il modello, come delle compenetrazioni dei ve-
stiti negli arti. Il Manuale accenna a questa cosa parlando di Skirt setting 
mode, ovvero modalità impostazioni della gonna. Non riprendo quello che 
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dice la guida, basta andarla a leggere; una cosa che però mi ha fatto un po’ 
ammattire è trovare dove andare a impostare le Skirt setting. 

Ebbene, al solito selezionare View e poi 
nella Character configuration > Body tocca-
re la cartella Body per vedere le sottocartel-
le. Selezionare la prima sottocartella pre-
sente (credo sia sempre la prima da sele-
zionare) e guardare nell’angolo in basso a 
destra dell’intera interfaccia.  

 

L’ultima icona presente è fatta (quasi) a forma di gonna e si chiama Set 
up skirt settings. Vi ho appena fatto risparmiare un’ora di vita ! 

 

Texture 
Nella Character configuration, quando 

importo un modello, in Body appare una 
cartella con il modello selezionato; quello 
che ho usato io è Attire_Female_02_Basic. 
Se clicco sul simbolo della cartella appaiono 
delle altre cartelle e contenuti.  

La cartella Surface material information 
contiene le texture utilizzate per differen-
ziare le varie parti. Per personalizzare mag-
giormente il modello, queste texture pos-
sono essere cambiate, cliccando 
sull’anteprima nella Character information 
e andando a scegliere una texture nei for-
mati consentiti dal programma. 

 

La cartella Additional texture contiene come si può intuire delle altre te-
xture, nella fattispecie una serie di volti (non so perché appaiano qui e per-
ché siano tutti uguali: prometto che approfondirò). 

Anche in Face esiste la stessa alberatura, con le texture per caratterizza-
re la faccia. 

 

Importare un 3D esterno 
Per importare un modello 3D creato con un altro programma bisogna 

creare un nuovo documento, nella Object configuration cliccare prima su 
Node (se si è creato un file di tipo object) o su Body (se si è creato un cha-
racter), poi  sull’icona Add from file , andare a prendere il file .obj o.fbx 
nella cartella del PC dove lo si è salvato. Non è possibile aprire un modello 
da File > Open; questo comando serve solo per i file .csmc . 
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Ora, mancherebbe da affrontare la parte  Create 3D object del pro-
gramma, ma francamente credo esuli un po’ dagli scopi di questo lavoro; 
già l’aver dedicato un numero consistente di pagine ai 3D characters penso 
sia più che sufficiente per avere un’idea di come lavori CSM. Mancano an-
che altri argomenti, tipo le ossature, ma non so se valga la pena affrontarli. 
Forse, in una eventuale nuova edizione magari cercherò di approfondire; se 
ho detto delle sciocchezze e il lettore sa come affrontare CSM con più con-
tezza, sarò lieto di farmelo spiegare.  

 

Blender 
Blender, www.blender.org, è un programma di modellazione 3D gratuito, 

potente e open-source. 
Molto versatile, con Blender è possibile realizzare oggetti o intere am-

bientazioni in 3D e poi utilizzarle in CSP. 
Sulla gestione del 3D creato con Blender e utilizzabile in CSP, consiglio il 

canale Youtube di Luca Malisan, tinyurl.com/ysepztem, ricco di video dedica-
ti e anche molto altro, ed è in italiano! Anche nel gruppo FB CSP Italia si 
possono trovare molti dei suoi tutorial video. 

 

Sweet Home 3D 
Esiste un programmino gratuito, Sweet Home 3D (SH3D, tin-

yurl.com/ybv2ra62), che permette di disegnare una casa in maniera molto 
semplice e intuitiva. Si possono creare i muri, aggiungere i serramenti, la 
mobilia ecc. Per me è stato molto utile in passato per aiutarmi a visualizza-
re la casa mentre era in costruzione (e quindi a migliorare i rapporti con il 
piastrellista, l'idraulico ecc.  ). Mi sono chiesto se fosse possibile utilizzar-
lo per creare viste dell'interno di abitazioni da utilizzare in CSP, e la risposta 
è che si può fare: SH3D esporta in .obj, formato che si può importare in 
CSP.  
  

https://www.blender.org/
htpps://tinyurl.com/ysepztem
https://tinyurl.com/ybv2ra62
https://tinyurl.com/ybv2ra62
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Colore 

Non sono un esperto di colore, raggruppo qualche informazione utile, 
un’infarinatura dei concetti base.  

Sull’argomento esistono molti testi e anche in rete si trova molto mate-
riale. 

 

Modelli RGB e CMYK 
RGB (tricromia) e CMYK (quadricromia) sono due modi differenti di rap-

presentare il colore.  
 

RGB è detto metodo additivo, perché variando l’intensità, in varie per-
centuali, di tre colori (Red, Green e Blue, rosso, verde e blu) vengono rap-
presentati tutti gli altri. Sommando i tre colori al 100% si ottiene il bianco, 
allo 0% si ottiene il nero; se i tre colori non sono allo 0% ma i loro valori so-
no uguali otteniamo un grigio; per tutte le altre combinazioni di percentuali 
ottengo i vari colori dello spazio RGB. Ciò è utilizzato ad esempio negli 
schermi dei monitor, in cui l’estrema vicinanza di elementi emettitori di lu-
ce dei tre colori non permette di vederli singolarmente, ma si vede il risul-
tato della somma di ciascuno. 

 

CMYK è invece un metodo sottrattivo: a partire da tre colori (Cyan, Ma-
genta e Yellow, ciano, magenta e giallo)  vengono ottenuti, sottraendo le 
varie percentuali, gli altri colori. Per giungere al bianco si devono sottrarre 
tutti i tre colori. Il nero si ottiene sommandoli, ma così facendo non si ot-
tiene un nero puro, ma una sorta di marrone scuro, il bistro, e va quindi ag-
giunto un pigmento ulteriore, nero (indicato con la K di Key, chiave, non B 
per non confonderlo con Blue). I pigmenti di stampa riflettono la luce che li 
colpisce e, a seconda di come siano affiancati o sovrapposti, restituiscono i 
vari colori. 

 

Per la loro natura, i due sistemi lavorano quindi in maniera diversa e so-
no adatti a scopi diversi: RGB è più idoneo alla rappresentazione di imma-
gini tramite apparecchi elettronici, CMYK è più adeguato per la stampa; se 
devo convertire un documento RGB, metodo più adatto a uno schermo e-
lettronico, in un’immagine che deve essere stampata, generalmente lo si 
deve convertire prima in CMYK, perché è con questo sistema che di solito 
lavorano le stampanti e le tipografie. Il programma cioè deve fare un'ope-
razione del tipo: "se devo stampare quel dato colore in CMYK invece di 
rappresentarlo in RGB, quale quantità dei singoli pigmenti CMYK devo me-
scolare?". 
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 RGB può rappresentare però più colori di CMYK; non potendo converti-
re quindi tutta la gamma cromatica alcuni colori andranno perduti. È per 
questo che spesso un’immagine stampata è meno vivace di un’immagine a 
video; si pone il problema quindi di effettuare una conversione con meno 
perdite possibile. Inoltre, non esiste un solo metodo RGB, come non esiste 
un solo metodo CMYK; variazioni dell’uno e dell’altro metodo sono chiama-
te profili colore. Per completare il quadro, dispositivi differenti mostreran-
no immagini con lo stesso profilo in maniera differente, così come stam-
panti differenti le stamperanno in modo diverso. Di norma, una tipografia 
dovrebbe suggerire il profilo colore CMYK a essa più adatto per la stampa, 
da inserire nelle Preferences > Color conversion insieme ad altre imposta-
zioni. 

 

Per produrre un documento da stampare dev’essere operata la conver-
sione da RGB a CMYK; ma CSP non è in grado di gestire in maniera corretta 
lo spazio colore CMYK, perché CSP non gestisce realmente il metodo CMYK: 
CSP opera con il sistema RGB. Vedi anche a pag. 55. 

 

Modelli HSV e HSL 
Non esistono solo gli spazi colore RGB e CMYK; nella Color Wheel di CSP i 

colori sono rappresentati o con il modello HSV o con l’HSL (chiamato HLS), 
modelli additivi. Si può passare da una all’altra rappresentazione cliccando 
sull’icona nell’angolo in basso a destra nella Color Wheel. 

 

HSV = Hue, Saturation, Value > Tinta, Saturazione, Valore. Sinonimi: HSB 
(B= Brightness), HSI (I=Intensity). 

HLS=  Hue, Lightness, Saturation  > Tinta,  Luminosità, Saturazione. 
 

I valori nello spazio HSV possono essere modificati agendo coi cursori 
nell’anello esterno per la Tinta (Hue), e nei due assi orizzontale (Saturazio-
ne, Saturation) e verticale (Valore, Value) nel quadrato interno; per agire 
sui valori dello spazio HLS bisogna passare alla rappresentazione HLS clic-
cando sull’iconcina in basso a destra.  

Lo spazio colore HLS ha un’altra rappresentazione, con un triangolo cen-
trale; per la Tinta (Hue) ci si muove ancora sull’anello esterno, così come 
l’asse orizzontale rappresenta ancora la Saturazione (Saturation). L’asse 
verticale ora rappresenta la Luminosità (Luminosity): 
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Spazio colore HSV 

 

 
Spazio colore HLS 

 
Altre risorse su questi argomenti: 
tinyurl.com/y7h5ma2z; 
tinyurl.com/4mduwnbn; 

en.wikipedia.org/wiki/HSL_and_HSV (in inglese); 
tinyurl.com/2t9pwnbp; 
tinyurl.com/3vfaxjrm; leggere anche i commenti a fine pagina di questo 

articolo, in cui l’autore dà ulteriori chiarimenti rispondendo a una doman-
da. 

 

La gestione del colore in CSP 
CSP gestisce e lavora nello spazio colore RGB, che è un modello additivo 

(vedi più sopra) ; è possibile lavorare con una simulazione dei colori che si 
avrebbero in CMYK (modello sottrattivo), andando in View > Color profile > 
Color profile preview settings e impostare il profilo colore in Profile for pre-
view. Per poter mantenere poi l’anteprima mentre si lavora o adocchiarla 
di tanto in tanto, sempre da View > Color profile scegliere Preview color 
profile. Ricordare sempre che si tratta di una stima di quelli che saranno i 
colori in CMYK, perché il programma in realtà non riesce a lavorare in quel-
lo spazio. L’applicazione del profilo si avrà solo in fase di esportazione 
dell’immagine, quando verrà effettivamente applicata la conversione nello 
spazio colore CMYK scelto in Preferences > Color conversion > Color conver-
sion settings > CMYK profile. 

 

Il consiglio che da più parti viene dato è comunque di salvare i propri la-
vori sempre in RGB e di esportare in CMYK solo alla fine. Inoltre, quando si 
deve intervenire sull’immagine CMYK perché troppo differente da quello 

https://tinyurl.com/y7h5ma2z
https://tinyurl.com/4mduwnbn
https://en.wikipedia.org/wiki/HSL_and_HSV
https://tinyurl.com/2t9pwnbp
https://tinyurl.com/3vfaxjrm
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che ci si aspetta, non riaprire questa ma andare a modificare il file RGB e 
fare un’ulteriore esportazione, poiché reiterando i passaggi RGB > CMYK > 
RGB ecc. la qualità peggiora. 
Per capire meglio l’argomento, leggere anche: 
- it.wikipedia.org/wiki/RGB; 
 it.wikipedia.org/wiki/Mescolanza_additiva;  
- it.wikipedia.org/wiki/CMYK;  it.wikipedia.org/wiki/Mescolanza_sottrattiva; 

- un articolo del sito ufficiale di CSP (in inglese):  tinyurl.com/3m34snze;  
- un articolo interessante sulla gestione del colore e il passaggio da RGB a 

CYMK (in inglese): tinyurl.com/4mduwnbn 
- un paio di video di Luca Malisan: tinyurl.com/yccmzb4t; 

tinyurl.com/mrw3hj6j    
 

Il nero vero 
I problemi relativi al colore si riflettono anche nella ricerca del nero ve-

ro.  Si deve ad es. stampare un documento avendo la necessità di mantene-
re il nero “nero” (es. i testi nei balloon, o i balloon stessi):  lavorando con 
un nero RGB 0, 0, 0 (o, cosa che abbiamo visto inutile, direttamente in 
CMYK) ed esportando poi in CMYK, se si va a campionare in un programma 
terzo si scopre che il nero poi tanto “nero” non è. 

Come si aggira questo problema? Semplice, al momento, in CSP non si 
può.  

Si possono esportare i testi a parte e fornirli all’editore separatamente, 
e poi ci penserà qualcun altro a far tornare i conti; oppure fare un passag-
gio in un programma che gestisca la quadricromia in cui realizzare i testi. 

 

Sull’ impossibilità  a impostare il nero in modalità CMYK leggere questi 
post sul gruppo FB CSP Italia: 

tinyurl.com/yc3axwbe; 
tinyurl.com/ynvfmwjj 

  

https://it.wikipedia.org/wiki/Mescolanza_additiva
https://it.wikipedia.org/wiki/Mescolanza_sottrattiva
https://tinyurl.com/3m34snze
https://tinyurl.com/4mduwnbn
https://tinyurl.com/yccmzb4t
https://tinyurl.com/mrw3hj6j
https://tinyurl.com/yc3axwbe
https://tinyurl.com/ynvfmwjj
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Strumenti per l’animazione 

Con CSP è possibile realizzare delle animazioni 2D, grazie a un articolato 
insieme di funzioni dedicate. 

 

Non ho avuto grandi frequentazioni con questa tecnica;  miei contatti 
con qualcosa di simile risalgono a molti anni fa, quando per lavoro imparai 
a usare Macromedia Flash, un programma -anche- di animazione vettoriale 
che ho presto disimparato. 

Per questo ho esitato molto a introdurre un capitolo sull’animazione e 
chiarisco che su questo tema probabilmente sarò inesatto e per forza di co-
se piuttosto incompleto. Tuttavia, credo che sia utile introdurre anche que-
sto aspetto del programma, per averne una panoramica più ampia, e quin-
di per scrivere questo capitolo mi sono messo a studiare un po’  .  

La mia trattazione ha lo scopo di abbreviare un po’ il processo di ap-
prendimento soprattutto dei termini e delle funzioni che CSP utilizza, in 
modo che di fronte a disquisizioni o a tutorial più esaustivi non ci si debba 
scervellare solo per capire di che cosa si sta parlando. Non è quindi mia in-
tenzione insegnare ad animare, anche perché al momento non ne ho le 
competenze, per cui non mi occuperò delle basi, dei principi, di timing 
chart, ecc.  

Per comprendere appieno la tecnica dell’animazione tradizionale, o 2D, 
qualche pagina non basta; esistono corsi, tutorial, siti e ovviamente nume-
rosi testi. Uno dei libri più recenti e completi sull’animazione è The Anima-
tor's Survival Kit di Richard Williams, tinyurl.com/27jc5368. 

 

Breve introduzione 
L’animazione è la tecnica con cui si fanno apparire in sequenza più dise-

gni leggermente differenti tra di loro, dando l’illusione di una variazione nel 
tempo - la più classica: il movimento -  dei soggetti disegnati.  

 

Un cartone animato 2D tradizionale nella sua essenza veniva realizzato 
facendo dei normali disegni su carta che poi venivano ricalcati sui rodovetri 
(cel in inglese), cioè dei fogli di acetato di cellulosa, un materiale plastico 
trasparente su cui è possibile dipingere il disegno definitivo. Quindi la strut-
tura base tradizionale era costituita da una parte immobile (o al più scorre-
vole), lo sfondo o fondale, su cui venivano appoggiati uno alla volta i vari 
disegni su acetato, tenuti in posizione da dei registri per il tempo necessa-
rio a fare uno scatto della macchina da presa e passare ai successivi. Walt 
Disney innovò la tecnica creando un sistema, la Multiplane Camera, per se-
parare la scena in più livelli, ampliando le combinazioni di acetati e permet-

https://tinyurl.com/27jc5368
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tendo più movimenti alla cinepresa. La Multiplane Camera è stata utilizzata 
per decenni, fino all’avvento delle tecniche digitali in tempi recenti. 

 

Nelle animazioni più economiche destinate alla massiccia serialità televi-
siva, come i cartoni di Hanna & Barbera (H&B; dalla fine degli anni ’50 in 
poi), su pochi rodovetri erano disegnati solo alcune parti dell’intero dise-
gno, come i corpi dei personaggi con movimenti limitati e ripetuti;  le teste 
con le espressioni del volto (in genere chiusura degli occhi e movimenti del-
la bocca) erano disegnate su rodovetri a parte, che venivano leggermente 
ruotati per dare un movimento oscillatorio che aggiungesse dinamismo. Se 
si osservano l’orso Yoghi, i Flintstones, Svicolone, Braccobaldo, insomma 
praticamente tutti i personaggi H&B (ormai in tv non passano più, ma si 
trovano in rete), a livello del collo hanno un cravattino, un colletto, una col-
lana, un fazzoletto, che serve a rendere meno visibile lo stacco tra il rodo-
vetro del corpo e quelli della testa. Dove queste mascherature non erano 
possibili (in tanti casi l’attaccature delle braccia al corpo, ad esempio) spes-
so si notano delle differenze nelle tonalità di colore, o delle ombre (date da 
leggeri sollevamenti dei rodovetri). Anche nelle vecchie produzioni seriali di 
molti cartoni giapponesi si notano queste cose. Organizzando preventiva-
mente bene i giunti anatomici si potevano però creare dei personaggi cre-
dibilissimi.  

 

Guardando i cartoni animati più datati e modesti, osservandoli consci di 
un po’ di queste cose, è possibile riconoscere il trucco dietro alla magia: 
fondali che si ripetono, bocche tutte uguali, movimenti stereotipati, ecc.; 
diverso era il lavoro riservato alle grosse produzioni cinematografiche, in 
cui era destinata maggior cura al disegno dei personaggi, alla fluidità dei lo-
ro movimenti. Talvolta, in queste opere si riprendevano prima delle perso-
ne vere che recitavano e poi i singoli fotogrammi erano ricalcati sul rodove-
tro, una tecnica chiamata Rotoscopio (dal nome dello strumento con cui si 
realizza). 

Ma anche per produrre i grandi successi, per rientrare nelle spese spes-
so venivano riciclate intere sequenze, magari ricalcando a loro volta i rodo-
vetri di prodotti precedenti: una panoramica di “prestiti” fra film Disney 
può essere vista all’indirizzo tinyurl.com/4waeruuz. 

 

Nella cinematografia, in generale, si è affermata storicamente la fre-
quenza di riproduzione standard di 24 fotogrammi al secondo: per ripro-
durre fluidamente i movimenti sono necessari 24 fotogrammi per ogni se-

https://tinyurl.com/4waeruuz
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condo di riproduzione. Ciò ha a che vedere con la fisiologia della visione, 
ovvero con il tempo con cui il cervello elabora le informazioni visive.  

 

Quando in animazione 2D si sceglie di far coincidere un disegno per ogni 
fotogramma si dice che si fa in 1 (animating on ones) o 24 fps (frames per 
second, fotogrammi al secondo). Spesso però si opta per animare in 2 o in 3 
(animating on twos o on threes): ciò significa che ogni disegno viene man-
tenuto per 2 o 3 fotogrammi e di conseguenza, pur rimanendo il numero di 
fotogrammi totali in un secondo pari a 24, i disegni per ogni secondo cala-
no a 12 (animazione in 2, o 12 fps) o a 8 (animazione in 3, o 8 fps): la fluidi-
tà del movimento rimane accettabile (specie a 12 fps) e, calando i disegni, 
calano anche il tempo e il costo per realizzare l’animazione. Le scene 
d’azione o con veloci cambiamenti sono rese meglio a 24 disegni per se-
condo, per cui i film d’animazione tradizionale sono in realtà spesso realiz-
zati in maniera mista. 

 

Animazioni con CSP 
Per realizzare un’animazione posso partire dall’interfaccia che ho utiliz-

zato finora per i fumetti e costituirne la struttura un passo alla volta, come 
vedo poco più avanti, in Animazione semplice, oppure posso partire dalla 
finestra dedicata New > Project > Animation, (vedi a pag. 81) che fornisce 
già in partenza l’ossatura base. 

 

In CSP edizione DEBUT non è possibile accedere a New > Project > Ani-
mation e quindi sono precluse molte delle opzioni dedicate all’animazione; 
però si può scegliere Illustration e mettendo la spunta a Create animated 
illustration si possono comunque realizzare delle brevi animazioni, fino a 
un massimo di 24 fotogrammi per 3 secondi totali di animazione. 
Nell’edizione PRO si può accedere ad Animation, ma pure qui c’è il limite 
massimo di 24 fotogrammi totali (Playback time) per ogni animazione rea-
lizzabile. Se imposto in New > Project > Animation > Timeline  la frequenza 
finale (Frame rate) a 24 fps è possibile solo un secondo di animazione, ma 
perdendo un po’ di fluidità e abbassando la frequenza a 8 fps si può au-
mentare il numero di secondi di animazione a 3 (24/8=3). Nell’edizione EX 
questo limite non c’è e virtualmente un’animazione a 24 fps potrebbe es-
sere indefinitamente lunga. In realtà la lunghezza è limitata da altre cose, 
ma per ora non ci importa.  
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Animazione semplice 
Suppongo di utilizzare l’edizione PRO, quindi ho a disposizione solo 24 

fotogrammi, per un totale massimo di 3 secondi di animazione a 8 fps. Per 
questo esempio imposto 12 fps per un totale di 2 secondi di animazione. 

La più semplice animazione possibile è formata da due disegni che si al-
ternano e differiscono tra di loro per qualche cosa; un cerchio e un quadra-
to, un cerchio in un punto e lo stesso cerchio in un altro punto, un cerchio 
piccolo e lo stesso cerchio più grande, e via dicendo: prima si vede un dise-
gno e poi l’altro. Si possono trovare dei tutorial che dicono di partire da un 
disegno, ma in realtà si tratta dello stesso disegno ripetuto due volte e la 
copia viene in qualche modo modificata per introdurre una differenza. 

Creo quindi un disegno con un livello linee e un livello colore,  lo duplico 
e lo modifico un po’, e poi inserisco le due versioni in due cartelle separate. 
Volendo, posso anche utilizzare un’immagine importata o dai Material. 

 

 
 

Abilito ora la palette Timeline dove vengono visualizzati i fotogrammi 
dell’animazione, da Window > Timeline. Se necessario, si può agganciare la 
palette al fondo del Canvas, trascinandola fino a che una banda rossa avvi-
sa che è possibile rilasciarla. La palette appena visualizzata è vuota. 

 

La timeline 
Quella appena attivata è solo una palette, un contenitore. Per avere 

un’effettiva timeline bisogna crearla nella palette Timeline sull’icona New 
timeline: 
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Si apre la finestra New timeline: 
 

 
 

Qui, tra i vari parametri impostabili ce ne sono due che definiranno la du-
rata dell’animazione: 
- Frame rate sono gli fps, cioè a quanti fotogrammi al secondo verrà ripro-

dotta l’animazione; indica quindi quanti cel potranno essere riprodotti al 
massimo* in ogni secondo; 

Playback time: tempo di riproduzione. Di default  indica da quanti foto-
grammi in totale è composta l’animazione. 

Dividendo Playback time per Frame rate otteniamo la durata in secondi 
dell’animazione. Se so già che la mia animazione dovrà durare per 5 secon-
di a 12 fps, in Playback time imposto 60 (12 fps x 5s = 60 fotogrammi) 

 

* Al massimo, perché in realtà posso utilizzare un minor numero di disegni rispet-
to a quelli impostati, decidendo di mantenere ogni disegno per più fotogrammi 
(vedi animazione in 2 o in 3, più sopra, pag. 59). 
 

Nel caso dell’immagine avremo quindi una durata di due secondi. Impo-
stando i due parametri con lo stesso valore, l’animazione dura un secondo. 

Come si vede, a fianco di Playback time è presente un menu a tendina. 
Le prime due opzioni del menu, Frame number (from 0) e Frame number 
(from 1), servono semplicemente a indicare che il primo fotogramma è il 
numero 0 o il numero 1;  

la terza opzione, Seconds + frame, fa scorrere l’animazione per il nume-
ro di secondi indicato più un numero di fotogrammi oltre ai secondi scelti; 
ad esempio, se imposto 2 + 4: 
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l’animazione viene ripetuta per due secondi e e poi aggiunge il numero 
di fotogrammi scelto alla fine; in questo caso ho scelto un Frame rate pari a 
12: 

 

 
 

Come si vede nelle immagini, il passaggio da un secondo all’altro è se-
gnato da una colorazione leggermente diversa dello sfondo 

La quarta opzione, Time code, consente di scegliere la durata in minuti, 
secondi, più un numero di fotogrammi arbitrario; nell’esempio imposto 1 
minuto, 7 secondi più 5 fotogrammi: 

 

 
 

Nell’immagine seguente vedo l’ultima parte dell’intera timeline. Ancora 
con Frame rate pari a 12, il conteggio dei 12 fotogrammi è stato ripetuto 
per 67 volte, cioè 67 secondi (un minuto = 60 secondi, più 7 secondi; ogni 
secondo contiene i 12 fotogrammi) e a questi sono stati aggiunti 5 foto-
grammi alla fine (sembrano 4, ma il conteggio inizia dall’ultima opzione 
Frame number utilizzata, che in questo caso era from 0): 

 

 
 

Se imposto il Frame rate a 24 fps, ogni secondo è composto da 24 foto-
grammi, come si vede nella prossima immagine, in cui ho impostato tutto 
come nella precedente, tranne il Frame rate: 

 

 
 

La quantità di fotogrammi visibile a schermo può essere modificata a-
gendo sulle icone Zoom Out e Zoom In della timeline: 

 

 
* * * 
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Torno alle impostazioni iniziali della timeline: Frame rate 12 e Playback 
time 24; faccio durare la mia animazione di due disegni per due secondi; do 
l’OK. 

Nella timeline che appare nella palette ci sono tre livelli, che rispecchia-
no quelli della Layer palette (Lp): un livello Paper e i due livelli delle cartelle 
con i disegni; ognuno di essi è chiamato traccia (track) e sono elencate nel-
la parte sinistra della palette, in verticale, con il loro nome.  

 

 
 

Tralascio per comodità il livello Paper; se ora lasciassi così l’animazione, 
verrebbero visualizzati entrambi i disegni per l’intera durata 
dell’animazione. Devo quindi fare in modo che un disegno sia visibile per 
metà animazione e l’altro per l’altra metà.  

 

Nella parte superiore di ogni traccia c’è un rettangolo sottile delimitato 
da due quadratini. Ogni parte di traccia racchiusa tra due quadratini è 
chiamata clip: 

 

 
 

Se col cursore mi sposto sulla parte superiore della clip, quando si trasforma 
in mano, posso con un click selezionare la clip e spostarla lungo la timeline:  

 

 
 

Nella stessa traccia ci possono essere più clip.  
 

Avvicino il cursore al quadratino che si trova 
all’estremità destra della timeline in corrispondenza della 
traccia della cartella 1 e, quando si trasforma…  

 
 

… trascino la fine della clip fino a metà timeline: 
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Faccio la stessa cosa nella traccia della cartella 2, prendendo il quadrati-
no a sinistra e trascinando l’inizio della clip fino a metà: 

 

 
 

Se ora clicco Play sui controlli di riproduzione, , i due di-
segni si alternano, ognuno per un secondo, mostrando l’animazione. Posso 
giocare con la durata dell’animazione ridimensionando opportunamente le 
varie clip e ricordando che la parte che verrà riprodotta è sempre quella 
compresa tra i due cursori blu che stanno a sinistra e a destra della timeli-
ne: anche questi possono essere spostati, facendo variare il punto di inizio 
e di fine della riproduzione: 

 

 

Qui ad esempio ho ridimensionato le clip 
fino a far occupare a ognuna due fotogram-
mi, poi ho trascinato il cursore blu di destra 
per fare in modo che dopo il fotogramma 4 
l’animazione riprendesse subito dall’1, senza 
attendere lo scorrere fino al fotogramma 24.  

In questo modo l’animazione dura solo 1/3 di secondo. 
 

Ora, nella Lp o nella timeline, seleziono la cartella 2 (quella che sta più in 

alto), e nei controlli clicco New animation folder    ; seleziono entrambe 
le cartelle con i disegni e le trascino nell’Animation folder appena creata, 

che ha questa icona:    .  
 

Questo è un passaggio abbastanza importante per capire come funziona 
l’animazione in CSP: infatti, una volta trascinate all’interno dell’Animation 
folder le due cartelle assumono lo stato di rodovetri. La loro miniatura, o 
icona, non è più  la classica cartella, ma mostra in piccolo il contenuto di 
ciascuna cartella. D’ora in poi possiamo considerare ogni cartella come un 
singolo disegno, l’unità minima dell’animazione o, come la chiama 
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all’inglese CSP, un cel. Notare che le icone che riguardano i cel ricordano 
proprio i rodovetri (le linee in alto sono dei fori che servono a posizionare 
correttamente i disegni). 

 

 
 

Le icone: New animation folder / New animation cel / Assign cel to frame / 
Remove cel e Animation folder aperta / chiusa 

 

La timeline però è di nuovo vuota; a questo punto mi metto col cursore 
sul primo fotogramma e clicco sull’icona Assign cel to frame: si apre la fine-
stra Select layer in cui posso scegliere una delle due cartelle.  

 

 
 

(posso anche cliccare col tasto destro nella timeline in corrispondenza 
del primo fotogramma, si apre una finestra analoga, ma con più opzioni, 
vedi a pag. 68).  

Scelgo Folder 1 e do l’OK. Nel primo fotogramma della timeline appare la 
miniatura della prima cartella, o cel. Se provo a premere Play, vedo che an-
che quando il cursore lascia il primo fotogramma, a schermo continuo a 
vedere il primo cel. Stoppo e metto il cursore sul  fotogramma 13; tasto de-
stro > Folder 2 (col tasto destro l’attribuzione è automatica e non serve da-
re l’OK). Ora ho il secondo cel sul fotogramma 13. Premo Play e vedo che 
fino a che il cursore è nei primi 12 fotogrammi vedo il primo cel, dopo, fino 
al 24, vedo il secondo cel.  

Se voglio far continuare l’animazione indefinitamente premo l’icona Lo-

op play . 
L’animazione parte subito, ma ho notato che quando sono presenti an-

che poche variazioni, con aggiunta di cel, i primi cicli arrancano un po’, 
vanno un po’ a scatti (ho un PC abbastanza scafato, non credo che dipenda 
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dalla macchina). Preferisco aspettare qualche secondo e vedere 
l’animazione fluida, per cui dal menu Animation > Playback settings ho 
messo la spunta a Render before starting playback. In questo modo CSP 
prima prepara l’animazione e poi la fa partire, facendo vedere già al primo 
ciclo l’animazione correttamente. 

 

Come si vede, nella timeline i cel caratterizzanti l’animazione appaiono 
solo all’inizio del loro secondo di competenza; anche dove non c’è nulla il 
cel visualizzato è quello stabilito all’inizio. 

 

 
 

Se seleziono un fotogramma nella “giurisdizione” di un cel e clicco New 
animation cel, nell’Animation folder della timeline viene aggiunto un cel, la 
sua miniatura viene inserita nella clip, e, nella Lp, viene aggiunta una nuova 
cartella all’interno dell’Animation folder corrispondente. Questa cartella 
contiene una struttura uguale a quella degli altri cel, nel mio caso un livello 
raster e uno vettoriale, entrambi vuoti, ma in cui posso disegnare se li sele-
ziono. Così faccio e poi creo una terza variazione del disegno. 

 

 
 

Nel mio esempio, ora dei 24 fotogrammi, 12 sono occupati dal primo 
cel, 9 dal secondo cel e 5 dal terzo. L’animazione dura sempre 2 secondi, 
perché non ho modificato né Playback time né Frame rate. 

Da quanto detto fin qui, emerge che un altro aspetto piuttosto rilevante 
nell’uso dei cel (ricordo che i cel sono i disegni all’interno di un’Animation 
folder) è che se voglio che siano costituiti da più livelli, in modo ad esempio 
da separare le lineart dai riempimenti, allora i livelli che li compongono de-
vono essere contenuti in una cartella: è questa cartella che viene conside-
rata cel dal programma; se i livelli non sono in una cartella, ognuno di essi 
verrà considerato un cel a sé.  
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Quando visualizzo un cel non è possibile visualizzarne un altro, per cui 
se decido di lavorare su di un cel, lavorerò solo su quello. Se i livelli svin-
colati dalla cartella sono ad esempio le lineart e i riempimenti, verranno 
rappresentati uno alla volta, perdendo il senso stesso di volerli mante-
nere insieme perché componenti di uno stesso cel. 

 

 
 

Nell’immagine qui sopra, a sinistra ho un’Animation folder con una serie 
di livelli raster all’interno: ognuno di essi è un cel. 

A destra ho aggiunto due livelli vettoriali (avrebbero potuto anche esse-
re raster, non cambia nulla), uno sopra al livello 6 e l’altro sopra al livello 5. 
Più precisamente ho inserito sopra al livello 5 un altro livello, che prende il 
nome 5a, mentre per il livello 6 prima l’ho selezionato, poi l’ho inserito in 
una cartella con Create folder and insert layer (la cartella prende il nome 
del livello) e infine ho inserito il nuovo livello sopra al 6, che si chiama Layer 
1. La coppia 5 e 5a non costituisce un unico cel, a differenza della coppia 6 
e Layer 1 all’interno della cartella. Non considerando i livelli 1, 2 e 3, fuori 
dall’immagine, i cel in questo caso sono i livelli 4, 5, 5a, e la cartella 6 (che 
contiene i livelli 6 e Layer 1). 5a è appunto un cel a sé stante; questo tipo di 
inserimenti possono esser fatti ad esempio se serve aggiungere un disegno 
inizialmente non previsto. 

Ciò che viene disegnato (o importato) in livelli esterni all’Animation fol-
der, magari nei livelli più bassi nella palette, rimangono immagini statiche e 
non sono “animabili”; possono essere usate come sfondi. 
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Aggiungere un cel 
Per aggiungere un cel posso mettermi in un punto della timeline e clicca-

re sull’icona New animation cel, quindi disegnare nel cel appena creato.  
Ma posso invece aggiungere un livello nell’Animation folder, con la diffe-
renza che il cel non appare immediatamente nella timeline: dopo aver ag-
giunto il livello, vado nella timeline nel punto in cui voglio aggiungere il cel, 
clicco col tasto destro e, nella finestra che appare, nella colonna a sinistra, 
clicco sul numero corrispondente al livello appena aggiunto (2, 
nell’esempio): 

 

 
 

A questo punto appare il cel e posso cominciare a disegnare. Similmen-
te, posso attribuire a un fotogramma un cel già disegnato. Se decido di ag-
giungere un cel con l’icona New animation cel dalla timeline, il relativo livel-
lo nell’Animation folder sarà vettoriale o raster a seconda del tipo di livello 
selezionato da cui si parte. 

Se voglio rimuovere un cel dalla timeline, clicco sull’icona Remove cel: 
verrà rimosso dalla timeline, appunto, ma rimarrà sia nella Lp, 
nell’Animation folder, sia nella raccolta dei cel nella relativa track, pronto a 
essere riassegnato se necessario:  
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Il cel è nella track e nella timeline 

 

 
Il cel non è più nella timeline, ma rimane 

nella track 

Tweening 
Uno dei modi più utilizzati per animare è procedere disegnando keyfra-

me prima e inbetween successivamente. Questo metodo è chiamato twee-
ning (abbreviazione di inbetweening, tradotto in questo caso come “inter-
calazione”). 

Keyframe (kf) letteralmente significa fotogramma chiave. È un foto-
gramma in cui si stabilisce una posa nodale; nell’animazione digitale è un 
fotogramma in cui vengono memorizzate varie proprietà presenti, come 
l’apparenza di un disegno  (es. dimensioni, opacità, colore, ecc.), la posizio-
ne, il livello di zoom, la rotazione dell’inquadratura, financo il volume 
dell’audio: definisce quindi uno “stato” nell’animazione. I kf vengono utiliz-
zati come paletti, come punti a cui gli altri fotogrammi devono far riferi-
mento. I kf sono generalmente posti all’inizio, alla fine e in mezzo (brea-
kdown frame) all’animazione, e sono importanti perché ne definiscono il 
carattere. Tradizionalmente, i kf sono realizzati dai key animator (animatori 
chiave), che appunto disegnano i punti fondamentali dell’animazione. 

Gli altri fotogrammi sono detti inbetween o tween (intercalari); sono i 
fotogrammi di transizione tra un kf e l’altro, ma non meno importanti. 
Nell’animazione tradizionale, questi fotogrammi sono affidati agli assistenti 
dei key animator, chiamati inbetweener (intercalatori). 

 

Onion skin 
Onion skin (letteralmente buccia di cipolla) è una funzione molto utile 

quando si stanno realizzando cel in serie, uno dopo l’altro, oppure per la 
realizzazione dei tween, ad esempio per aumentare il numero di cel e otte-
nere un’animazione più fluida.  Questa funzione permette di visualizzare in 
trasparenza i cel precedenti e successivi a quello in cui stiamo lavorando. 

Per abilitare l’onion skin, cliccare sull’icona Enable onion skin  sulla 
Timeline palette, oppure dal menu Animation > Show animation cels > Ena-
ble onion skin. Nello stesso percorso si può aprire la finestra Onion skin set-
tings, nella quale si possono impostare alcune opzioni, come quanti cel vi-
sualizzare prima e/o dopo quello su cui si sta lavorando, con quale colore 
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identificarli e il livello di trasparenza della visualizzazione. A proposito dei 
colori, nelle immagini che seguono li ho cambiati, ma è consigliato tenere il 
blu per il cel precedente e il verde per quello successivo, perché è una con-
venzione utilizzata in vari programmi di animazione. 
 

 
 

 
 

Light table 
Uno strumento che permette di realizzare nuovi cel in maniera simile 

all’onion skin, ma in modo più versatile, è Light table (tavolo luminoso). 
Suppongo di voler inserire dei nuovi disegni per rendere più fluida 
un’animazione: posso caricare nel Light table i cel disegnati da usare come 
riferimenti, ad esempio il precedente e il successivo di quello che sto per 
disegnare e, tramite le funzionalità del tavolo luminoso, utilizzare delle i-
stanze (non i disegni effettivi, ma delle loro copie su cui posso intervenire 
senza modificare gli originali) dei due per disegnare un terzo cel  che sia 
una via di mezzo tra di essi. Questi cel “virtuali” possono essere spostati, 
deformati ecc., ma i loro corrispettivi “reali” non saranno affetti dalle tra-
sformazioni. 

Abilito la finestra Animation cels dal menu Window.  
 

Se è selezionato un cel (chiamato anche target cel nella User guide, ovve-
ro cel di destinazione), tale finestra lo mostra nella sua parte inferiore, in 
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una zona chiamate Edited cel.  Il cel in questa zona è “reale” e se lo si modi-
fica, le variazioni si rifletteranno nell’animazione. 

 

 

Nella parte superiore si trovano la Pro-
perty bar: 

 

 
 

e la Command bar: 
 

 
 

dell’Animation cels palette. 

 

È possibile spostare la Command bar nella parte inferiore della palette, 
cliccando sulle tre lineette in alto a sinistra e mettendo la spunta a Set 
command bar below list. 

Nella riga inferiore della Command bar ci sono tre icone: Enable/disabe 
light table tool, Show cel-specific light table e Show general light table. 

L’area Edited cel non è l’unica al di sotto della Command bar: se clicco 
sulle icone Show cel-specific light table e/o Show general light table, si atti-
vano le rispettive aree Cel-specific light table e General light table, che so-
no il tavolo luminoso vero e proprio, che ha queste due modalità. 

 

 

Per utilizzare dei cel della timeline o 
dei livelli della Lp come riferimento nel 
tavolo luminoso, bisogna prima regi-
strarli in una delle due parti, cel-specific 
o general light table. 

 

Cel-specific light table. I cel caricati in 
quest’area sono collegati al cel 
nell’Edited cel; cambiando questo, non 
saranno più visibili. 

 

General light table. I cel caricati qui 
rimangono visibili anche se si cambia il 
cel di destinazione. 
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L’icona a lampadina Enable/disable light table tool  serve a attiva-
re/disattivare lo strumento tavolo luminoso; quando lo si attiva, si passa 
immediatamente a Operation > Light table, e sul Canvas appaiono le mani-
glie e il crocicchio di modifica. Disattivandolo si torna allo strumento pre-
cedente; passando a un altro strumento viene disattivato. 

 

Per registrare un cel o livello in uno dei due tipi di tavolo luminoso basta 
trascinarlo (drag and drop) nel light table voluto. Si può anche selezionare 

e aggiungerlo col pulsante Register selected layer  nella Command bar (o 
con l’analogo comando da Animation > Light table), ma funziona solo con il 
cel-specific light table. 

Le immagini o i cel registrati sono chiamati light table layer (livelli tavolo 
luminoso). Come detto, possono essere trasformati o spostati e si può 
cambiare il colore al livello, il tutto senza che le modifiche intacchino i loro 
originali. 

Se ancora non è stato impostato un cel di destinazione, non è possibile 
registrare dei livelli nel tavolo cel-specific.   

È possibile registrare come light table layer anche un file come un altro 
.clip, un’immagine (.bmp, .jpg, .tif o .tga) o un documento Photoshop, da 
Animation > Light table > Select and register file o dall’icona a cartella nella 
Command bar; oppure un livello copiato da un altro Canvas, da Animation 
> Light table > Register layer copied from another canvas. 

Infine, se è attiva l’Onion skin, si possono registrare le immagini visualiz-
zate da essa nel tavolo luminoso cel-specific,da Animation > Light table > 
Register onion skin images; vengono mantenuti i colori, ma non l’opacità; 
inoltre per questi cel l’Onion skin non funzionerà più.  

Nella riga superiore della Command bar, la prima icona è Enable light 
table. Serve a rendere visibili nel Canvas i livelli presenti nel tavolo lumino-
so. 

Sempre nella Command bar si possono deregistrare i livelli registrati, se-
lezionando quelli che si vogliono togliere e cliccando sull’icona che rappre-

senta il livello con il cestino . Selezionando il target cel l’icona cambia e 

rappresenta più livelli con il cestino  : cliccandola si deregistrano tutti i 
livelli light table 

Normalmente, selezionando un altro livello nella Lp, cambia il cel 
nell’Edited cel. Se clicco l’icona Lock current animation cel as editing target 

 il cel visualizzato non cambia anche passando a un altro livello; tuttavia 
è possibile passare al precedente o al successivo con le due icone a freccia, 
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proprio accanto. Questo può essere utile se sto registrando come light ta-
ble layer dei livelli della Lp, perché passando da un livello all’altro nella Lp, 
se non viene bloccato cambia l’Edited cel; di conseguenza si rischia di regi-
strare un light table layer per il cel sbagliato. 

L’icona New animation cel serve a inserire un nuovo cel nella timeline, se 
ci sono fotogrammi disponibili vuoti, in analogia alla stessa icona nella 
palette Timeline. 

 

Colore del light table layer e opacità possono essere modificati dalla 
Property bar, in cui si trovano anche i comandi per i flip, per regolare 
l’opacità solo per il layer selezionato o per tutti e per resettare la posizione 
dei livelli. 

 

 
 

Le icone legate ai livelli del tavolo luminoso mi hanno fatto un po’ ammat-
tire, perché non riuscivo a trovarne una legenda che me ne spiegasse il signifi-
cato. In realtà, le icone sono solo una: la lampadina (la 3 nell’immagine), che 
appare in un light table layer o nella Lp quando i livelli sono stati registrati co-
me light table layer. Mi chiedevo cosa significassero le lampadine barrate (4 e 
5) prima di capire che sono le icone lampadina sovrapposta all’icona del livello 
attivo (la penna, 1) o alla spunta che appare quando è selezionato un altro li-
vello oltre a quello attivo (2). L’icona 6 indica che il light table layer è l’istanza 
dell’Edited cel, la 7 idem, ma con il tavolo luminoso non attivo. 

 

Tweening automatico 
In CSP, come in altri programmi di animazione, si possono definire i ke-

yframe disegnandoli e poi lasciare al programma la realizzazione dei tween. 
In realtà, con il tweening automatico non vengono creati dei veri cel: non è 
che nuovi cel disegnati vengano posti nella timeline, ma l’effetto ottenuto è 
ciò si avrebbe se questi cel ci fossero davvero. 

 

Una piccola animazione con  tweening automatico in  CSP può essere 
fatta come segue. Per prima cosa faccio un disegno semplice su due livelli: 
un cerchio vettoriale con un riempimento arancione raster, in cui segno in 
piccolo punto nero eccentrico (che servirà a visualizzare la rotazione 
dell’immagine): 
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Inserisco i due livelli in una cartella e salvo il tutto come Material (vedi a 
pag. 123 del libro). 

Ora creo un nuovo documento Comics (non è indispensabile partire da 
Animation), nel mio caso un semplicissimo quadrato, con tutte le misure 
indispensabili uguali (Canvas, Trim e Inner border) senza Bleed (vedi nel li-
bro). Trascino sul Canvas il disegno fatto inizialmente e lo posiziono in un 
angolo: 

 
 

Dalla palette Timeline (se non è visibile abilitarla da Window > Timeline) 
clicco su New timeline. Come Frame rate e Playback time metto 8 
(l’animazione durerà un secondo). Dall’elenco delle track seleziono la trac-
cia con la cartella del disegno. Metto il cursore al fotogramma 1 e clicco 

sull’icona Enable keyframe on this layer,  (ricordarsi di fare 
quest’operazione, perché indispensabile). Seleziono lo strumento Object; 
nell’area del Canvas appaiono le varie maniglie e il crocicchio di riferimento 
delle trasformazioni. Trascino il crocicchio al centro (più o meno) del dise-
gno: 

 

 
 

 

Questo serve per impostare il centro della rotazione che voglio attribui-
re al disegno. Non appena sposto il crocicchio, nella traccia, sul primo foto-
gramma appare un piccolo rombo violetto, significa che è stato impostato 
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un keyframe (il rombo sarebbe apparso per una qualsiasi modifica, non so-
lo per lo spostamento del crocicchio): 

 

 
 

Avvicino il cursore a una delle maniglie fino a quando diventa una dop-

pia freccia arcuata , e poi ruoto il disegno: 
 

 
 

A questo punto ho finito di impostare il primo kf. Mi sposto sul foto-
gramma 5 col cursore, sempre sulla traccia della cartella col disegno: 

 

 
 

… e sposto e ruoto il disegno: 
 

 
 

Anche al fotogramma 5 appare il simbolo del kf: 
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Infine seleziono il simbolo del kf al fotogramma 1 
(quando è selezionato mostra un bordo rosso): 

 

 
 

Tasto destro > Copy; mi sposto al fotogramma 8, tasto destro > Paste: 
incollare alla fine dell’animazione lo stesso kf garantisce che ci sia lo stesso 
stato all’inizio e alla fine, di modo che l’animazione in loop non abbia scatti: 

 

 
 

La creazione dell’animazione in tweening è terminata, ora basta preme-
re Play per riprodurla. L’effetto finale, se tutto è stato fatto correttamente, 
è il cerchio che, ruotando, da un angolo si sposta diagonalmente verso 
l’angolo opposto e poi torna indietro. Niente di che insomma, però di otto 
fotogrammi ne sono stati realizzati effettivamente solo tre, gli altri li ha 
messi CSP; in situazioni più complesse può essere comodo. Questa è una 
delle strade per arrivare a questo risultato, nulla vieta di alterare un po’ i 
passaggi appena visti e vedere cosa accade.  

L’animazione a 8 fps è piuttosto povera, si potrebbe provare a farla a 24, 
esercizio che lascio al lettore.  

 

Interpolazione 
Il tweening può essere realizzato secondo tre tipi di interpolazione (cioè 

tre modi per ricavare i fotogrammi mancanti): quella che inserisce automa-
ticamente nell’esempio CSP è la modalità smooth; quando si usa questa 
modalità, i kf sono, come già visto, violetti. Le altre due sono linear, con i 
rombi  verdi, e hold, con i rombi gialli. Ad ogni kf può essere attribuito uno 
dei tre metodi; per cambiarlo, selezionare il kf, tasto destro > Switch ke-
yframe to xxx interpolation, dove xxx è uno degli altri due metodi. L’utilizzo 
di uno o l’altro fa cambiare la riproduzione: una visualizzazione gentile con 
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smooth, un po’ più secca con linear, fino a piuttosto brusca con hold; le dif-
ferenze nel dettaglio possono essere viste al link tinyurl.com/5dt8eb4b. 

È possibile visualizzare graficamente i passaggi tra kf cliccando sulla pri-

ma icona a sinistra nella palette Timeline, Graph Editor  :  
 

 
 

Dal Graph Editor è possibile anche apportare modifiche alle tracce. Det-
tagli sull‘uso del Graph Editor qui: tinyurl.com/ynbxjnm6. 

Quando vengono apportate delle modifiche alle proprietà di un kf (es. 
opacità), nella traccia, sotto al rombo colorato, appare un triangolino vuo-
to: 

 
 

Movimenti di camera 
I movimenti di camera sono delle variazioni dell’inquadratura ottenute 

muovendo la macchina da presa (Mdp).  
Ovviamente in CSP non ho realmente una Mdp reale che posso spostare 

per ottenere un movimento di camera, però posso giocare con quello che 
c’è a schermo, spostandolo, ruotandolo o scalandolo, utilizzando una fun-
zione del programma chiamata 2D camera, che simula la Mdp. 

 

Per aggiungere i movimenti di camera devo innanzitutto aggiungere un 
nuovo livello di animazione 2D camera folder , da Animation > New anima-
tion layer > 2D camera folder, che apparirà sia come cartella nella Lp che 
come track nella Timeline palette. A questa cartella il programma dà il no-
me Camera 1 e al suo interno devo trascinare i livelli che voglio siano affetti 
dal movimento di camera.  

https://tinyurl.com/5dt8eb4b
https://tinyurl.com/ynbxjnm6
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Passo allo strumento Object e attorno alla zona di output 
dell’animazione (vedi output frame nel prossimo paragrafo) appaiono i 
manipolatori. 

 

 
 

Nella Tool property, in Display mode, decido come visualizzare ciò che 
sto facendo durante la lavorazione: con Show’s camera’s field of view vedo 
ciò che vede la Mdp e quindi in sostanza il rendering finale (ciò che si vedrà 
alla fine), mentre con Show fields guides vedo come variano i movimenti 
della Mdp, sovrapposti al fotogramma su cui si trova il cursore nella timeli-
ne. Ricordarsi di mettera la spunta ad Animation >  Show 2D camera frame 
e Show camera path. 

 

Per mostrare meglio, ho realizzato una stupidissima animazione da 24 
fotogrammi, a 8 fps: scelto un output frame, ho disegnato 8 cel, ripetendo 
in ogni cel a mano libera alcuni segni: un 2 e una linea rossa all’interno 
dell’output frame, un 1 all’esterno.  

 

 
 

Ho inserito gli 8 cel tre volte, con la stessa sequenza, fino a riempire tutti 
e 24 i fotogrammi: 
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Essendo ogni cel molto simile agli altri, premendo Play in pratica si ve-
dono i tre segni che vibrano un po’; quando si avvia l’animazione, una ma-
schera copre ciò che rimane al di fuori dell’output frame; il segno 1 quindi 
non compare mai. 

 

 
 

Inserisco una 2D camera folder e trascino al suo interno  l’Animation 
folder dell’animazione; nella timeline compare la track della 2D camera. 

 

 
 

Se seleziono lo strumento Object, appaiono i manipolatori in corrispon-
denza dell’output frame. Non facendo nient’altro, premendo Play 
l’animazione è identica a prima. 

 

Porto il cursore al primo fotogramma e poi tocco 
uno dei manipolatori sul Canvas: nella track della 2D 
camera appare un kf.  

 
 

Copio il kf sul fotogramma 24, in modo da garantire il loop fluido, e poi 
mi sposto su vari altri fotogrammi, in ognuno dei quali faccio delle modifi-
che tramite i manipolatori: ingrandisco il quadro, lo rimpicciolisco, lo ruoto. 
Nei fotogrammi su cui mi sono posizionato appaiono altri kf. Se faccio par-
tire ora l’animazione, vedo che il contenuto del quadro cambia notevol-
mente: i vari segni si ingrandiscono e si rimpiccioliscono, ruotano, entrano -
anche l’1- ed escono dal quadro.  È come se avessi spostato la Mdp, avessi 
fatto degli zoom-in (avvicinamento), degli zoom-out (allontanamento), del-
le rotazioni. 
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CSP tiene traccia di queste variazioni: se in Animation metto la spunta a 
Show camera path, e poi, dalla Tool property dello strumento Object, in 
Display mode scelgo Show field guides, allora a schermo compaiono le linee 
corrispondenti ai vari movimenti di camera effettuati e alle posizioni del 
quadro nei kf. Se abilito Show 2D camera frames, la posizione del quadro è 
evidenziata in ogni fotogramma.  

 

 
 

Se eseguo l’animazione, queste linee scompaiono fino alla sua interru-
zione. 

Da quello che ho visto in vari tutorial, i movimenti di camera vengono 
aggiunti quando il resto dell’animazione è stata più o meno completata. 
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La finestra New > Project > Animation 
 

 
Questa immagine è una composizione di più immagini; in realtà le opzioni non sono tutte 

visibili contemporaneamente 
 

Iniziare a fare un’animazione da due disegni credo sia più un caso parti-
colare; presumo che chi voglia realizzare un’animazione con CSP sia più 
tentato a partire dalla sezione dedicata quando si parte dalla finestra New, 
ovvero Animation. È possibile realizzare un’animazione anche partendo da 
New > Illustration e mettendo la spunta a Create animated illustration. La 
sostanza del discorso non cambia molto, anche se partendo da Illustration 
si hanno meno opzioni, ma può essere utile per chi ha l’edizione DEBUT di 
CSP, che non permette di selezionare Animation tra i tipi di Project. 

Con riferimento all’immagine precedente, scegliendo Animation in Pro-
ject (1), la finestra che appare è simile. Simile perché qui ho fatto una com-
posizione di quasi tutte le opzioni attivate, ma di default alcune non lo so-
no. A prima vista sembra anche uguale alla finestra New di Show all comic 
settings (vedi a pag. 27 del libro), ma se ne differenzia in molti aspetti. 
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La voce Save to: (3) appare solo se si mette la spunta a Manage files u-
sing folders (25): questo, analogamente al salvataggio dei file multipagina 
con i fumetti, salva un file .cmc, contenitore di più file .clip, nella cartella 
indicata in Save to: . 

Le misure indicate nei Presets (5) sono quelle relativa all’area del rettan-
golo blu nell’anteprima o output frame, ovvero la dimensione dell’area che 
verrà visualizzata nel render finale (9, 10 e 11, rappresentata in 13); il Can-
vas (che non è presente come voce) è un po’ più grande per permettere di 
disegnare anche al di fuori di quest’area. Lo spazio indicato nel Preset è suf-
ficiente se l’animazione avrà movimenti di camera limitati (mi viene in 
mente solo uno zoom-in);  

 

se è previsto che ci sia un movi-
mento più ampio, come una car-
rellata, bisogna aggiungere dello 
spazio nelle direzioni che ver-
ranno interessate.  

Per far ciò bisogna mettere la 
spunta a Overflow frame (15) , 

 

poi modificare i valori in 
Width e Height  proporzio-
nalmente o con le misure 
esatte (Specified scale/size, 
16), e modificare nello 
schemino il punto di rife-
rimento  delle  nuove misu-  
re (Reference point, 17) ed eventualmente impostare un offset (uno spo-
stamento rispetto al punto di riferimento scelto, 18) dell’Output frame (che 
deve rimanere comunque all’interno dell’Overflow frame). 

 

Partendo da New > Animation vale sostanzialmente quanto già detto, 
però la palette Timeline viene aperta automaticamente, con già una timeli-
ne utilizzabile. 

 

Una cosa che mi sembra potenzialmente molto interessante è che è 
possibile salvare un’animazione come Material e poterla utilizzare in al-
tre animazioni. Se l’animazione in cui viene inserito ha un Playback time 
diverso da quello del Material, questo comunque mantiene il proprio, 
per cui può cambiare il numero di fotogrammi su cui si sviluppa. 
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All’inizio del capitolo dicevo che anche l’edizione EX  ha dei limiti nella 

durata delle animazioni possibili (vedi  a pag. 59).  
Questi limiti ipotetici sono di 179.999 fotogrammi o di 10.000 livelli. Il 

limite dei fotogrammi si può verificare nella finestra New > Timeline: inse-
rendo in Playback time (29 nell’immagine a pag. 81) il valore 180.000, il 
programma corregge automaticamente a 179.999 (selezionare un altro 
campo per vedere la correzione):  

 

 
 

il limite dei livelli è generale, non solo per l’animazione, ed è dichiarato nel-
le Release notes della v 1.8.4 (vedi tinyurl.com/mr23zany).  

Sono numeri piuttosto elevati ed è difficile raggiungerli (per questo scri-
vo ipotetici), specie se si fanno delle animazioni amatoriali. Se sfrutto tutti i 
179.999 fotogrammi a 24 fps ottengo circa 125 minuti di animazione: non 
poco, considerando poi che scene diverse possono essere realizzate in file 
diversi e montate successivamente con programmi di video-editing. 
Un’altra cosa da considerare è che aumentando molto il numero di foto-
grammi o di livelli, il computer utilizzato farà più fatica a elaborarli (ovvia-
mente in base alla sua potenza) e a restituire un’animazione fluida. Forse è 
meglio quindi suddividere il lavoro in più parti da assemblare in un secondo 
momento. 
  

https://tinyurl.com/mr23zany
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Scorciatoie da tastiera 

 Scorciatoie per la versione Windows; per la versione Mac sostituire Alt 
con Option e CTRL con Command. È riportato anche l’utilizzo di tasti con 
determinati Tool o SubTool. Per una lista completa, vedere tin-

yurl.com/mskjpf45. 
Alcune delle shortcut trovate nel Manuale non funzionano (non le ho ri-

portate); in qualche caso dovrebbe trattarsi della mappatura della tastiera: 
ricordo infatti che le scorciatoie riportate nel Manuale sono pensate per la 
tastiera in configurazione ENG; molte sono valide anche per la configura-
zione ITA, ma non tutte (es. non si possono usare combinazioni di tasti con 
le parentesi quadre perché nella tastiera italiana anche le parentesi quadre 
si ottengono con una combinazione di tasti). Per passare da una configura-
zione all’altra premere Shift + Alt (bisogna aver installato la tastiera US nel 
sistema operativo). In altri casi invece sospetto che si tratti della mia tastie-
ra, che già tempo addietro ho visto che non supporta alcune combinazioni 
di tasti.  

Ho raccolto le shortcut secondo ordinamenti diversi, perché a volte cer-
co il significato di una combinazione di tasti (qui sotto), altre l’azione che 
voglio ottenere (a pag. 93); infine c’è una raccolta per contesti (a pag. 100).  

Imp. pers. significa impostazione personale, non di default. 
 

Note 
*1 Crop: di default, ha Z come shortcut. Però di default non funziona (nella mia 
copia almeno, ma credo che sia così per tutti, suppongo che dipenda dalla 
mappatura della tastiera italiana). Ho così riassegnato Z a Crop, che diventa 
quindi un’impostazione personale. 
    Create Folder and insert layer:  indicato nella Guida con la shortcut CTRL + G, 
ma non presente, di default, nel mio CSP. 

*2 Canvas precedente/successivo: l’ordine con cui vengono selezionati i canvas 
non dipende dall’ordine di creazione/apertura, ma dall’ordine in cui sono stati 
selezionati precedentemente all’uso di questo comando. 

*3 Mostra/nasconde ruler: nel Manuale, la shortcut riportata è CTRL + Shift + 
click sull’icona, ma non funziona, mentre funziona così come l’ho scritta. 

*4 Aumenta densità: secondo varie fonti, la shortcut è  CTRL + Shift + P. Oltre a 
non averla di default, non riesco neanche a impostarla come shortcut persona-
lizzata, per cui ho ripiegato su CTRL + Shift + è. 

*5 Aumenta/diminuisci opacità: nel programma, di default, sarebbero CTRL + [  
e  CTRL + ], ma essendo già le parentesi quadre una combinazione di tasti, è 

impossibile attuarle con la tastiera italiana. Perciò le ho personalizzate.  

https://tinyurl.com/mskjpf45
https://tinyurl.com/mskjpf45
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Ordine per tasto o combinazione di tasti 
Tasto o combinazione 

 di tasti 
Azione 

lineetta      - Ruota il foglio in senso antiorario; Rota-
te counterclockwise 

virgola      , Subtool precedente 
punto       .    Subtool successivo 

apostrofo       ‘ Dimensione pennello –  (imp. pers.) 
0 Attiva/Disattiva Refer multiple (stru-

mento Fill) 
5  Brightness/Contrast… (livello di regola-

zione) (imp. pers.) 
6  Gradient Map (livello di regolazione) 

(imp. pers.) 
à Ruota il foglio in senso orario; Rotate 

clockwise 
A  Colora con il colore selezionato; Convert 

to drawing color (imp. pers.) 
B Pennello > Aerografo > Decorazioni;  

Brush > Airbrush >  Decoration 
C Alterna tra Colore trasparente (Transpa-

rent color) e quello tra Main e Sub color 
che era selezionato precedentemente 

D + click su elemento del 
livello 

Seleziona livello; Select layer 

E  Gomma > Hard eraser > Vector  (il pas-
saggio a Gomma è di default, gli altri 
imp. personali) 

F  Flip orizzontale (imp. pers.) 
G Gradiente > Riempimento > Freeform 

gradient; Gradient > Fill > Freeform gra-
dient 

H + sposta col cursore Muovi il foglio  = Mano = Move 

I Contagocce; Eyedropper 
ì  Dimensione pennello +   (imp. pers.) 

J Mescola colori; Blend 
K + sposta col cursore Muovi livello = Move layer 

L  Tavolo luminoso > Modifica la timeline; 
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Light table  >  Edit timeline 

M Selezione; Marquee 
O Object 

P Penna > Matita; Pen > Pencil 
R Ruota; Rotate 

S  Flip verticale (imp. pers.) 
T Testo (passa all’ultimo Sub Tool selezio-

nato dello strumento Text) 
U Figure (passa all’ultimo Sub Tool sele-

zionato dello strumento Figure) 
ù  Zoom temporaneo 

W Bacchetta Magica; Auto select 
X Alterna tra Colore principale (Main co-

lor) e Colore secondario (Sub color) 
Y passa all’ultimo Sub Tool selezionato 

dello strumento Correct  line; poi alter-
na tra Pinch vector line e Correct line 
width (imp. pers.) 

Z  Ritaglia; Crop (imp. pers.) *1 

F1 Training and Tutorials; Trucchi e tutorial 
ufficiali online (default) 
Aiuto/Guida in linea; Help/Online User 
Guide (imp. pers.) 

F2 Taglia; Cut 
F3 Copia; Copy 

F4 Incolla; Paste 
F11  Mostra/nasconde righelli (rulers) (imp. 

pers.) 
Backspace Cancella; Delete 

 Cancella; Delete (nella selezione) 
Canc Cancella; Delete 

 Cancella; Delete (nella selezione) 
Spazio Mano (per muovere il foglio); Hand 

Spazio + sposta col curso-
re; 

Muovi il foglio = Mano  = Move  

Tab Mostra > Nascondi tutte le palette; 
Show/Hide all palettes 

CTRL + - Zoom - 
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CTRL +  Canc Cancella; Delete. 
Cancella; Delete (nella selezione) 

CTRL + ‘  Diminuisci opacità (imp. pers.) *5 

CTRL + + Zoom + 
CTRL + 0 Adatta lo zoom  allo schermo; Fit to 

screen 
CTRL + 1 Snap to ruler 

CTRL + 2 Snap to Special ruler 
CTRL + 3 Snap to grid 

CTRL + 4 Alterna Special ruler 
CTRL + 5  Level Correction… (livello di regolazione) 

(imp. pers.) 
CTRL + 6  Reverse gradient (livello di regolazione) 

(imp. pers.) 
CTRL + A Seleziona tutto; Select all 

CTRL + Alt + 0 Zoom al 100% 
CTRL + Alt + click sulla mi-

niatura del livello 
Togli la selezione del contenuto di un li-
vello 

CTRL + Alt + G Clip to layer below 

CTRL + Alt + S  Salva con nome; Save as... 
CTRL + Alt + Shift + K Shortcut settings; a me non funziona, 

l'ho sostituita con CTRL + Alt + Shift + M 
CTRL + Alt + Shift + M Shortcut settings (imp. pers.) 

CTRL + Alt + Spazio + click Zoom - 
CTRL + Alt + trascina il cur-

sore 
Cambia la dimensione del pennello 

CTRL + B Cambia il colore del livello (Layer pro-
perty > Layer color) 

CTRL + Backspace Cancella; Delete. 
Cancella; Delete (nella selezione) 

CTRL + C  Copia 
CTRL + click su miniatura 

livello 
Seleziona il contenuto di un livello 

CTRL + click sul livello (nel-
la Layer palette)  

Collegare un livello 

CTRL + D Deseleziona 

CTRL + E Unisci sotto; Merge with layer below 
CTRL + G  Create Folder and insert layer (quelli se-
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lezionati) (imp. pers.) *1 

CTRL + I Colore complementare (inverte -
negativo- i colori del contenuto del livel-
lo) 
Gradiente inverso (inverte -negativo- i 
colori del gradiente) 

CTRL + ì  Aumenta opacità (imp. pers.) *5 
CTRL + J  Vista da tutti i lati; All sides view (imp. 

pers.) 
CTRL + K Preferences 

CTRL + N Nuovo documento; New 
CTRL + O Apri; Open 

CTRL + ò  Reset display (se il foglio è ruotato e zoo-
mato, lo raddrizza e lo adatta allo schermo) 

CTRL + P Stampa; Print 
CTRL + Q Esci; QuitCLIP STUDIO PAINT 

CTRL + R Mostra/Nascondi righelli laterali 
CTRL + S Salva; Save 

CTRL + Shift + Alt  Gomma (Eraser) temporaneo (imp. pers.) 
CTRL + Shift + Alt + click 

sulla miniatura del livello 
Seleziona l'overlap (Seleziona l’area del 
contenuto di un livello che si sovrappo-
ne alla selezione del contenuto di un al-
tro livello); Select Overlap 

CTRL + Shift + Alt + M  Impostazioni delle Shortcut; Shortcut 
settings (imp. pers.) 

CTRL + Shift + Alt + Y Impostazioni delle Modifier Key; Modi-
fier Key Settings 

CTRL + Shift + click su un 
elemento di un livello  

Seleziona il livello; Select layer 

CTRL + Shift + click sulla 
miniatura di un altro livel-

lo 

Aggiungi, a una selezione, la selezione 
del contenuto di un altro livello 

CTRL + Shift + D   Riseleziona (carica l’ultima selezione 
creata); Reselect 

CTRL + Shift + E Unisci i livelli  visibili; Merge visible la-
yers 

CTRL + Shift + è  Aumenta densità (imp. pers.) *4 

CTRL + Shift + G Estrai i livelli dalla cartella (e elimina la 
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cartella); Ungroup Layer Folder 

CTRL + Shift + I Inverti selezione; Invert selected area 
CTRL + Shift + M  Nuovo livello vettoriale; New Vector La-

yer (imp. pers.) 
CTRL + Shift + N Nuovo livello raster; New Raster Layer 

CTRL + Shift + O Diminuisci densità del pennello; Reduce 
brush density 

CTRL + Shift + S Salva con nome; Save as... 
CTRL + Shift + T Trasformazione libera; Free Transform 

CTRL + Shift + Tab Canvas precedente; Previous Canvas*2 

CTRL + Shift + V Paste to shown position 
CTRL + Shift + V Incolla su un nuovo layer, al centro del 

Canvas; Paste to shown position  
CTRL + Shift + Z Ripristina; Redo 

CTRL + Spazio + click Zoom + 
CTRL + Spazio + trascina a 

dx/sx   
Zoom 

CTRL + T Scala/Ruota; Scale/Rotate 

CTRL + Tab Canvas successivo; Next Canvas*2 

CTRL + tocca il contenuto 
di un livello raster  

Muovi contenuto livello raster (tempo-
raneo)  

CTRL + tocca il contenuto 
di un livello vettoriale  

Object su livello vettoriale (temporaneo)  

CTRL + U, su livello raster Tinta/Saturazione; 
Hue/Saturation/Luminosity… 

CTRL + V Incolla; Paste 
CTRL + W Chiude documento; Close 

CTRL + X Taglia; Cut 
CTRL + Y Ripristina; Redo 

CTRL + Z Annulla; Undo 
Shift + 5  Tone Curve… (livello di regolazione) 

(imp. pers.) 
Shift + 6  Hue/Saturation/Luminosity  (livello di 

regolazione) (imp. pers.) 
Shift + Alt + click su sele-

zione 
Seleziona dalla selezione 

Shift + Alt + E Unisci i livelli selezionati; Merge selec-
ted layers 
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Shift + Alt +S Salva come; Save as... 

Shift + B  Bordo selezione (mostra/nascondi); Se-
lection border (imp. pers.) 

Shift + Backspace Cancella fuori dalla selezione; Delete ou-
tside selection 

Shift + Canc Cancella fuori dalla selezione; Delete ou-
tside selection 

Shift + click sull’icona  del 
ruler sul livello*3 

Mostra/nasconde righello (ruler) 

Shift + click sulla miniatura 
della maschera 

Abilita/Disabilita la maschera 

Shift + F7 Inverti selezione; Invert selected area 

Shift + Spazio + doppio 
click  sul foglio  

Raddrizza il foglio; Reset rotation 

Shift + Spazio + trascina 
cursore 

Ruota il foglio;Rotate 

Shift + Tab Nascondi la Tiltle Bar > Nascondi la Me-
nu Bar > Mostra tutto; Hide Title Bar > 
Hide Menu Bar > Mostra tutto 

Shift + V   Mostra/Nascondi Selection Launcher 
(imp. pers.) 

Alt + Spazio + click Zoom – 
Alt + Spazio + trascina a 

dx/sx 
Zoom 

Alt + ‘ Livello sotto 

Alt + Backspace Riempi; Fill 
Alt + Canc Riempi; Fill 

Alt + click sull’icona Create 
layer mask (nella Com-

mand bar della Layer 
palette) 

Maschera la selezione 

Alt + click sull’icona New 
Raster Layer (nella Com-

mand bar della Layer 
palette)  

Visualizza la finestra di dialogo New Ra-
ster Layer  

Alt + click sull’icona New 
Vector Layer (nella Com-

mand bar della Layer 

Visualizza la finestra di dialogo New Vec-
tor Layer  
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palette)  

Alt + click sull’icona occhio 
del livello  

Mostra un solo un livello/Mostra tutti i 
livelli 

Alt + click sulla miniatura 
della maschera 

Mostra/Nascondi l’area mascherata 

Alt + ì  Livello sopra (imp. pers.) 
Alt + L  Duplica livello (imp. pers.) 

Alt + trascina il livello Duplica livello 
Alt + trascina l’icona del 

ruler 
Copia il ruler su un altro livello 

Alt + trascina la miniatura 
della maschera 

Duplica la maschera 

AltGR;  
CTRL + Alt 

Diverse funzioni temporanee, a seconda 
del tool selezionato:  
- Zoom: passa da temporaneamente da 
ingrandimento a rimpicciolimento e vi-
ceversa (se selezionato Zoom in passa a 
Zoom out, e viceversa);  
- Operation, Fill, Gradient, Freeform 
gradient, Text: passa a Eyedropper;  
- Magic Wand: in modalità Select new, 
Select additionally e Select already se-
lected part passa a Deselect;  
-  Pen, Pencil, Brush, Airbrush, Decora-
tion, Eraser, Blend, Correct line: trasci-
nando la penna o il mouse aumenta o 
diminuisce la dimensione dello stru-
mento. 
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Ordine per azione 
Dove, in Azione, ci sono più descrizioni separate da  > , significa che pre-

mendo più volte il tasto indicato si alternano le azioni descritte. 
Dove, in Tasto o combinazione di tasti, sono presenti più righe, significa 

che esistono più modi per compiere quell’azione, una  per ogni riga. 
 

 Azione Tasto o combinazione di tasti 

A Abilita/Disabilita la maschera Shift + click sulla miniatura della 
maschera 

 Adatta lo zoom  allo schermo; Fit 
to screen 

CTRL + 0 

 Aggancia agli Special ruler; Snap to 
Special ruler 

CTRL + 2 

 Aggancia ai ruler; Snap to ruler CTRL + 1 
 Aggancia alla griglia; Snap to grid CTRL + 3 

 Aggiungi, a una selezione, la sele-
zione del contenuto di un altro li-
vello 

CTRL + Shift + click sulla miniatu-
ra dell’altro livello 

 Aiuto/Guida in linea; Help/Online 
User Guide (imp. pers.) 

F1  (imp. pers.) 

 Alterna Special ruler CTRL + 4 
 Alterna tra Colore principale 

(Main) e Colore secondario (Sub) 
X 

 Alterna tra Colore trasparente 
(Transparent) e quello tra Main e 
Sub color che era selezionato pre-
cedentemente 

C 

 Annulla; Undo CTRL + Z 
 Apri; Open CTRL + O 

 Attiva/Disattiva Refer multiple 
(strumento Fill) 

0 

 Aumenta densità CTRL + Shift + è (imp. pers.) *4 

 Aumenta opacità CTRL + ì  (imp. pers.) *5 

B Bacchetta Magica; Auto select W 

 Bordo selezione (mostra / nascon-
di); Selection border 

Shift + B (imp. pers.) 

 Brightness/Contrast… (livello di re-
golazione) 

5  (imp. pers.) 
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C Cambia il colore del livello (Layer 
property > Layer color) 

CTRL + B 

 Cambia la dimensione del pennello CTRL + Alt + trascina il cursore 

 Cancella fuori dalla selezione; Dele-
te outside selection 

Shift + Backspace; 
Shift + Canc 

 Cancella; Delete 
(anche per le selezioni) 

Backspace; Canc; 
CTRL + Canc;  
CTRL + Backspace 

 Canvas precedente; Previous Can-
vas 

CTRL + Shift + Tab*2 

 Canvas successivo; Next Canvas CTRL + Tab*2 

 Chiude documento; Close CTRL + W 

 Clip to layer below CTRL + Alt + G 
 Collegare un livello CTRL + click sul livello (nella La-

yer palette)  
 Colora con il colore selezionato; 

Convert to drawing color 
A  (imp. pers.) 

 Colore complementare (inverte  i 
colori del contenuto del livello) 
Gradiente inverso (inverte  i colori 
del gradiente) 

CTRL + I 

 Contagocce; Eyedropper I 

 Copia CTRL + C  
 Copia il ruler su un altro livello Alt + trascina l’icona del ruler 

 Copia; Copy F3 
 Correct  line (passa all’ultimo Sub 

Tool selezionato dello strumento); 
poi alterna tra Pinch vector line e 
Correct line width (imp. pers.) 

Y 

 Create Folder and insert layer 
(quelli selezionati) 

CTRL + G  (imp. pers.) *1 

D Deseleziona CTRL + D 
 Dimensione pennello - ‘  (apostrofo; imp. pers.) 

 Dimensione pennello + ì  (imp. pers.) 
 Diminuisci densità del pennello; 

Reduce brush density 
CTRL + Shift + O  

 Diminuisci opacità CTRL + ‘ (imp. pers.) *5 

 Duplica la maschera Alt + trascina la miniatura della 
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maschera 

 Duplica livello Alt + L  (imp. pers.); 
Alt + trascina il livello 

E Esci; QuitCLIP STUDIO PAINT CTRL + Q 
 Estrai i livelli dalla cartella (e elimi-

na la cartella); Ungroup Layer Fol-
der 

CTRL + Shift + G 

F Figure (passa all’ultimo Sub Tool 
selezionato dello strumento Figure) 

U 

 Flip orizzontale F  (imp. pers.) 
 Flip verticale S  (imp. pers.) 

G Gomma (Eraser) temporaneo CTRL + Shift + Alt  (imp. pers.) 
 Gomma > Hard eraser > Vector   E (il passaggio a Gomma è di de-

fault, gli altri imp. personali) 
 Gradient Map (livello di regolazio-

ne) 
6  (imp. pers.) 

 Gradiente > Riempimento > Free-
form gradient; Gradient > Fill > 
Freeform gradient 

G 

I Incolla su un nuovo livello, al cen-
tro del Canvas; Paste to shown 
position  

CTRL + Shift + V 

 Incolla; Paste CTRL + V; 
F4 

 Inverti selezione; Invert selected 
area 

CTRL + Shift + I; 
Shift + F7 

L Level Correction… (livello di regola-
zione) 

CTRL + 5  (imp. pers.) 

 Livello sopra Alt + ì  (imp. pers.) 
 Livello sotto Alt + ‘  (imp. pers.) 

M Mano (per muovere il foglio); Hand Spazio 

 Maschera la selezione Alt + click sull’icona Create layer 
mask (nella Command bar della 
Layer palette) 

 Modifier Key Settings; Impostazioni 
delle Modifier Key 

CTRL + Shift + Alt + Y 

 Mostra > Nascondi tutte le palette; 
Show/Hide all palettes 

Tab 
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 Mostra un solo un livello/Mostra 
tutti i livelli 

Alt + click sull’icona occhio del 
livello  

 Mostra/nasconde righello (ruler) Shift + click sull’icona  del ruler 
sul livello*3;  
F11  (imp. pers.) 

 Mostra/Nascondi l’area maschera-
ta 

Alt + click sulla miniatura della 
maschera 

 Mostra/Nascondi righelli laterali CTRL + R 

 Mostra/Nascondi Selection Laun-
cher 

Shift + V  (imp. pers.) 

 Muovi contenuto livello raster 
(temporaneo)  

CTRL + tocca il contenuto di un 
livello raster  

 Muovi il foglio = Mano = Move  Spazio + sposta col cursore; 
H + sposta col cursore 

 Muovi livello = Move layer K + sposta col cursore 

 Nascondi la Tiltle Bar > Nascondi la 
Menu Bar > Mostra tutto; Hide Tit-
le Bar > Hide Menu Bar > Mostra 
tutto 

Shift + Tab 

N Nuovo documento; New CTRL + N 
 Nuovo livello raster; New Raster 

Layer 
CTRL + Shift + N 

 Nuovo livello vettoriale; New Vec-
tor Layer 

CTRL + Shift + M  (imp. pers.) 

O Object O 
 Object su livello vettoriale (tempo-

raneo)  
CTRL + tocca il contenuto di un 
livello vettoriale  

P Penna > Matita; Pen > Pencil P 

 Pennello > Aerografo > Decorazio-
ni; Brush > Airbrush >  Decoration 

B 

 Preferences CTRL + K 

R Raddrizza il foglio; Reset rotation Shift + Spazio + doppio click  sul 
foglio  

 Reset display (se il foglio è ruotato 
e zoomato, lo raddrizza e lo adatta 
allo schermo) 

CTRL + ò  

 Reverse gradient (livello di regola-
zione) 

CTRL + 6 (imp. pers.) 
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 Riempi; Fill Alt + Backspace; 
Alt + Canc 

 Ripristina; Redo CTRL + Y; 
CTRL + Shift + Z 

 Riseleziona (carica l’ultima selezio-
ne creata); Reselect 

CTRL + Shift + D   

 Riseleziona; Reselect CTRL + Shift + D 

 Ritaglia; Crop Z  (imp. pers.) *1 

 Ruota il foglio in senso orario; Ro-
tate clockwise 

à 

 Ruota il foglio; Rotate Shift + Spazio + trascina cursore 
 Ruota in senso antiorario; Rotate 

counterclockwise 
- (lineetta) 

 Ruota; Rotate R 

S Salva come; Save as... Shift + Alt + S; 
CTRL + Alt + S; 
CTRL + Shift + S 

 Salva; Save CTRL + S 

 Scala/Ruota; Scale/Rotate CTRL + T 
 Seleziona dalla selezione Shift + Alt + click su selezione 

 Seleziona il contenuto di un livello CTRL + click su miniatura livello 
 Seleziona il livello; Select layer CTRL + Shift + click su un ele-

mento del livello; 
D + click su elemento del livello 

 Seleziona l'overlap (Seleziona 
l’area del contenuto di un livello 
che si sovrappone alla selezione 
del contenuto di un altro livello); 
Select Overlap 

CTRL + Shift + Alt + click sulla 
miniatura dell'altro livello 

 Seleziona tutto; Select all CTRL + A 

 Selezione; Marquee M 
 Shortcut settings; Impostazioni del-

le Shortcut  
CTRL + Alt + Shift + K (default) 

  CTRL + Alt + Shift + M (imp. pers., 
perché la combinazione di de-
fault a me non funziona) 

 Stampa; Print CTRL + P 
 Strumento Blend J 
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 Subtool precedente ,  (virgola) 

 Subtool successivo . (punto) 

T Taglia; Cut CTRL + X; 
F2 

 Tavolo luminoso > Modifica la Ti-
meline; Light table  >  Edit timeline 

L  

 Testo (passa all’ultimo Sub Tool se-
lezionato dello strumento Text) 

T 

 Tinta/Saturazione/Luminosità; 
Hue/Saturation/Luminosity  (livello 
di regolazione) 

Shift + 6  (imp. pers.) 

 Tinta/Saturazione/Luminosità; 
Hue/Saturation/Luminosity… 

CTRL + U, su livello raster 

 Togli la selezione del contenuto di 
un livello 

CTRL + Alt + click sulla miniatura 
del livello 

 Tone Curve… (livello di regolazione) Shift + 5  (imp. pers.) 
 Trasformazione libera; Free Tran-

sform 
CTRL + Shift + T 

 Trucchi e tutorial ufficiali online; 
Training and Tutorials 

F1 (default); io ho assegnato a F1 
la guida online. 

U Unisci i livelli  visibili; Merge visible 
layers 

CTRL + Shift + E 

 Unisci i livelli selezionati; Merge se-
lected layers 

Shift + Alt + E 

 Unisci sotto; Merge with layer be-
low 

CTRL + E 

V Vista da tutti i lati; All sides view CTRL + J  (imp. pers.) 
 Visualizza la finestra di dialogo 

New Raster Layer  
Alt + click sull’icona New Raster 
Layer (nella Command bar della 
Layer palette)  

 Visualizza la finestra di dialogo 
New Vector Layer  

Alt + click sull’icona New Vector 
Layer (nella Command bar della 
Layer palette)  

Z Zoom Alt  + Spazio + trascina a dx/sx; 
CTRL + Spazio + trascina a dx/sx   

 Zoom - CTRL + -; 
CTRL + Alt + Spazio + click; 
Alt  + Spazio + click 
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 Zoom + CTRL + +; 
CTRL + Spazio + click 

 Zoom al 100% CTRL + Alt + 0 

 Zoom temporaneo ù  
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Ordine per contesto 
Contesto Azione Tasto o combinazione di ta-

sti 

Brush size 
Dimensione 
pennello 

Dimensione pennello - ‘    apostrofo (imp. pers.) 
Dimensione pennello + Ì  (imp. pers.) 

 
Cambia la dimensione del pen-
nello 

CTRL + Alt + trascina il cur-
sore 

Colore Alterna tra Colore principale 
(Main color) e Colore seconda-
rio (Sub color) 

X 

Alterna tra Colore trasparente 
(Transparent color) e quello tra 
Main e Sub color che era sele-
zionato precedentemente 

C 

Colore complementare (inverte 
i colori del contenuto del livello) 

CTRL + I  

 
Hue/Saturation/Luminosity… CTRL + U 

Correction 
layer 
Livelli di re-
golazione 

Brightness/Contrast…  5               (imp. pers.) 
Level Correction…  CTRL + 5  (imp. pers.) 

Tone Curve…  Shift + 5  (imp. pers.) 
Gradient Map  6               (imp. pers.) 

Hue/Saturation/Luminosity   Shift + 6  (imp. pers.) 
Reverse gradient  CTRL + 6  (imp. pers.) 

Edit  
Modifica 

Annulla CTRL + Z 
Cancella - Delete Backspace; Canc;  

CTRL + Backspace;  
CTRL + Canc 

Colora con il colore selezionato 
- Convert to drawing color 

A  (imp. pers.) 

Copia CTRL + C;  
F3 

Crop Z  (imp. pers.) *1 
Cut CTRL + X;  

F2 
Delete outside selection Shift + Backspace;  

Shift + Canc 
Esci; Quit CTRL + Q 
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Fill Alt + Backspac;  
Alt + Canc 

Flip Orizzontale F  (imp. pers.) 

Flip Verticale S  (imp. pers.) 
Incolla; Paste CTRL + V;  

F4 
Paste to shown position (incolla 
su un nuovo layer, al centro del 
Canvas) 

CTRL + Shift + V 

Ripristina; Redo CTRL + Y;  
CTRL + Shift + Z 

Riempi Alt + Backspace;  
Alt + Canc 

Scala/Ruota; Scale/Rotate CTRL + T 
Taglia; Cut CTRL + X;  

F2 
Trasformazione libera; Free 
transform 

CTRL + Shift + T 

Undo CTRL + Z 

File Apri documento; Open CTRL + O 
Chiude documento; Close CTRL + W 

Impostazioni delle Modifier Key; 
Modifier Key Settings 

CTRL + Shift + Alt + Y 

Impostazioni delle Shortcut; 
Shortcut Settings 

CTRL + Shift + Alt + K (de-
fault);  
a me non funziona e l’ho 
cambiata in: 
CTRL + Shift + Alt + M (imp. 
pers.) 

Nuovo documento; New CTRL + N 

Nuovo livello raster; New Raster 
Layer 

CTRL + Shift + N 

Preferences CTRL + K 
Stampa; Print CTRL + P 

Quit CLIP STUDIO PAINT CTRL + Q 
Salva; Save CTRL + S 

Salva con nome; Save as CTRL + Alt + S;  
CTRL + Shift + S;  
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Shift + Alt + S;  

Help Trucchi e tutorial ufficiali online; 
Training and Tutorials 

F1 (default) 

 Aiuto; Help; Guida Utente; User 
Guide 

F1  (imp. pers.) 

Layer Mask 
Maschere 
di livello 

Abilita/Disabilita la maschera Shift + click sulla miniatura 
della maschera 

Duplica la maschera Alt + trascina la miniatura 
della maschera 

Maschera la selezione Alt + click sull’icona Create 
layer mask (nella Command 
bar della Layer palette) 

Mostra/Nascondi l’area ma-
scherata 

Alt + click sulla miniatura 
della maschera 

Layer 
Livelli 

Aggiungi, a una selezione, la se-
lezione del contenuto di un al-
tro livello 

CTRL + Shift + click sulla mi-
niatura dell’altro livello 

Cambia il colore del livello CTRL + B 
Cancella la selezione CTRL + Alt + click sulla mi-

niatura del livello 
Clip to layer below CTRL + Alt + G 

Collegare un livello CTRL + click sul livello (nella 
Layer palette) 

Create Folder and insert layer 
(quelli selezionati) 

CTRL + G  (imp. pers.) *1 

Duplica livello Alt + L  (imp. pers.);  
Alt + trascina su o giù il livel-
lo da duplicare  

Incolla su un nuovo livello, al 
centro del Canvas 

CTRL + Shift +V 

Seleziona il livello; Layer selec-
tion 

D + click su elemento del li-
vello;  
CTRL + Shift + click su ele-
mento del livello 

Livello sopra Alt + ì  (imp. pers.) 

Livello sotto Alt + ‘ (imp. pers.) 
Unisci i livelli selezionati; Merge 
selected layers 

Shift + Alt + E 
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Unisci i livelli  visibili; Merge vi-
sible layers 

CTRL + Shift + E 

Unisci sotto; Merge with layer 
below 

CTRL + E 

Mostra un solo un livel-
lo/Mostra tutti i livelli 

Alt + click sull’icona occhio 
del livello  

Muovi contenuto livello raster 
(temporaneo) 

CTRL + tocca il contenuto di 
un livello raster 

Muovi il foglio; Hand; Mano  H + sposta col cursore; 
Spazio + sposta col cursore; 

Muovi contenuto livello; Move 
layer 

K + sposta col cursore 

New Raster Layer; Nuovo livello 
raster 

CTRL + Shift + N 

New Vector Laye; Nuovo livello 
vettoriale 

CTRL + Shift + M  (imp. pers.) 

Object su livello vettoriale 
(temporaneo)  

CTRL + tocca il contenuto di 
un livello vettoriale  

Seleziona il contenuto di un li-
vello 

CTRL + click sulla miniatura 
del livello 

Seleziona overlap (Seleziona 
l’area del contenuto di un livello 
che si sovrappone alla selezione 
del contenuto di un altro livello) 

CTRL + Shift + Alt + click sul-
la miniatura del livello 

Togli la selezione del contenuto 
di un livello 

CTRL + Alt + click sulla mi-
niatura del livello 

Estrai i livelli dalla cartella (e e-
limina la cartella); Ungroup La-
yer Folder 

CTRL + Shift + G  con la car-
tella selezionata 

Visualizza la finestra di dialogo 
New Raster Layer  

Alt + click sull’icona New 
Raster Layer (nella Com-
mand bar della Layer 
palette) 

Visualizza la finestra di dialogo 
New Vector Layer  
 
 

Alt + click sull’icona New 
Vector Layer (nella Com-
mand bar della Layer 
palette)  
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Ruler 
Guide 

Duplica livello del ruler Alt + trascina il livello del ru-
ler 

Copia ruler su un altro livello Alt + trascina l’icona del ru-
ler sull’altro livello 

Mostra/nasconde ruler (guide) Shift + click sull’icona del ru-
ler sul livello*3; F11  (imp. 
pers.) 

Select 
Selezioni 

Aggiungi, a una selezione, la se-
lezione del contenuto di un al-
tro livello;  

CTRL + Shift + click sulla mi-
niatura dell’altro livello 

Cancella (nella selezione) Backspace;  
Canc;  
CTRL + Backspace;  
CTRL + Canc 

Cancella al di fuori della sele-
zione 

Shift + Canc; 
Shift + Backspace 

Deseleziona CTRL + D 
Inverti selezione CTRL + Shift + I; 

Shift + F7 
Riseleziona (carica l’ultima sele-
zione creata) 

CTRL + Shift + D   

Select all CTRL + A 
Seleziona overlap (Seleziona 
l’area del contenuto di un livello 
che si sovrappone alla selezione 
del contenuto di un altro livello) 

CTRL + Shift + Alt + click sul-
la miniatura del livello 

Seleziona tutto CTRL + A 

Tool  
Strumenti 
 

Bacchetta Magica; Magic wand W 
Blend J 

Contagocce; Eyedropper I 
Correct line (passa all’ultimo 
Sub Tool selezionato dello stru-
mento Correct  line); alterna tra 
Pinch vector line e Correct line 
width  (imp. pers.) 

Y 

Edit timeline > Light table L  

Gomma temporanea; Eraser 
temporaneo 

CTRL + Shift + Alt  (imp. pers.) 
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Eyedropper I 

Figure (passa all’ultimo Sub Tool 
selezionato dello strumento Fi-
gure) 

U 

Gomma > Hard eraser > Vector   E  (il passaggio a Gomma è di 
default, gli altri imp. perso-
nali) 

Gradiente > Riempimento > 
Freeform gradient; Gradient > 
Fill > Freeform gradient 

G 

Selezione; Marquee M 

Modifica la timeline > Tavolo 
luminoso; Edit timeline > Light 
table 

L  

Object O 
Penna > Matita P 

Pennello > Aerografo > Decora-
zioni; Brush > Airbrush >  Deco-
ration 

B 

Raddrizza il foglio Shift + Spazio + doppio click  
sul foglio  

Ruota; Rotate R + trascina cursore; 
Shift + Spazio + trascina cur-
sore 

Seleziona dalla selezione Shift + Alt + click su selezio-
ne 

Testo (passa all’ultimo Sub Tool 
selezionato dello strumento 
Text) 

T 

Sub Tool Sub Tool precedente ,    virgola 

Sub Tool successivo .    punto 

Tool  
Property 

Attiva/Disattiva Refer multiple 
(strumento Fill) 

0 

Aumenta densità CTRL + Shift + è (imp. pers.) *4 

Diminuisci densità CTRL + Shift + O 
Aumenta opacità CTRL + ì  (imp. pers.) *5 

Diminuisci opacità CTRL + ‘  (imp. pers.) *5 

View Adatta lo zoom  allo schermo CTRL + 0 
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Alterna Special ruler CTRL + 4 

Bordo selezione; Selection bor-
der (mostra/nascondi) 

Shift + B  (imp. pers.) 

Fit to screen CTRL + 0 
Mostra/Nascondi righelli laterali 
graduati 

CTRL + R 

Mostra/Nascondi Selection 
Launcher 

Shift + V 

Reset display (se il foglio è ruo-
tato e zoomato, lo raddrizza e lo 
adatta allo schermo) 

CTRL + ò  

Ruota in senso orario; Rotate 
clockwise 

à 

Ruota in senso antiorario ; Ro-
tate counterclockwise 

-    lineetta 

Selection Launcher (mo-
stra/nascondi) 

Shift + V  (imp. pers.) 

Snap alla griglia; Snap to grid CTRL + 3 
Snap ai ruler; Snap to ruler CTRL + 1 

Snap agli Special ruler; Snap to 
Special ruler 

CTRL + 2 

Zoom - CTRL + - 
Zoom + CTRL + + 

Zoom 100% CTRL + Alt + 0 
Zoom adatta allo schermo CTRL + 0 

Window Vista da tutti i lati; All Sides 
View 

CTRL + J  (imp. pers.) 

Canvas precedente; Next Can-
vas 

CTRL + Shift + Tab *2 

Canvas successivo; Previous 
Canvas 

CTRL + Tab *2 

Nascondi la Tiltle Bar > Nascon-
di la Menu Bar > Mostra tutto; 
Hide Title Bar > Hide Menu Bar 
> Mostra tutto 

Shift + Tab 

Mostra > Nascondi tutte le 
palette  
 

Tab 
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Zoom Zoom Alt  + Spazio + trascina a 
dx/sx; 
CTRL + Spazio + trascina a 
dx/sx   
ù + trascina a dx/sx   

Zoom + CTRL + + ; 
CTRL + Spazio + click 

Zoom – CTRL + - ; 
Alt + Spazio + click 

Zoom al 100% CTRL + Alt + 0 
Zoom finestra (adatta allo 
schermo) 

CTRL + 0 
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Mappa shortcut  
Per la tastiera italiana, ho raccolto varie shortcut e realizzato l'immagine 

seguente, scaricabile per la stampa. Si basa sull’analoga immagine  realizza-
ta da czartamop per la tastiera US e pubblicata su Deviantart 
(tinyurl.com/6tnfxu7c), che poi ho integrato e ampliato.  

 

 
Mappa delle shortcut con Windows - tastiera italiana   

Shortcut pin-up  
Della Mappa ho poi fatto una versione da attaccare alla tavoletta Wa-

com Cintiq da 24 pollici che utilizzo, ordinando i tasti che abbiano almeno 
una shortcut  in maniera arbitaria in due colonne. Una volta stampata, ho 
tagliato le due colonne e le ho attaccate ai lati dello schermo della Cintiq 
per avere le scorciatoie più vicine; essendo miope, sono d’aiuto.  

 

 
Shortcut pin-up per Cintiq 

Scrivo per Cintiq 24 pollici perché l’ho otti-
mizzata per la mia tavoletta; ovviamente nulla 
vieta di utilizzarla su altri dispositivi, se si adat-
ta.  

 

Le mappe possono essere scaricate 
all’indirizzo tinyurl.com/422yheth. 

 

htps://tinyurl.com/6tnfxu7c
https://tinyurl.com/422yheth
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